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Introduction

Printing describes how to install the printer drivers on Windows and Mac computers for the ComColorExpress
FS2100C.

This document covers the following topics:

Installing printer drivers on Windows computers

Setting up the printing connections on Windows computers

Printing from Windows computers

Installing printer drivers on Mac computers

Setting up Mac computers for printing

Printing from Mac computers

ComColorExpress FS2100C print options

Using printing methods other than the printer driver to print to the ComColorExpress FS2100C

For information about setting up network servers and client computers to use the ComColorExpress FS2100C, see
Configuration and Setup. For general information about using the printer, your computer, application software, or
network, see the documentation that accompanies those products.

For information about supported operating systems and system requirements, see Configuration and Setup.

Terminology, conventions, and documentation resources

This document uses the following terminology and conventions to refer to the ComColorExpress FS2100C, printer,
and supported operating systems.

Term or convention

Refers to

Aero

FS2100C Server (in illustrations and examples)

Command WorkStation

Fiery Command WorkStation

Printer ComColor GL

FS2100C Server ComColorExpress FS2100C

macOS All supported Mac operating systems. For a complete list, see System Requirements in
Configuration and Setup.

Windows All supported Windows operating systems. For a complete list, see System Requirements in

Configuration and Setup.
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Term or convention

Refers to

A danger concerning operations that may lead to death or injury to persons if not performed
correctly. To use the equipment safely, always pay attention to these warnings.

/A\WARNING

A warning concerning operations that may lead to injury to persons if not performed correctly. To

use the equipment safely, always pay attention to these cautions.

/\CAUTION

Operational requirements and restrictions. Be sure to read these items carefully to operate the
equipment correctly, and to avoid damage to the equipment or property.

The following documentation resources are available for the ComColorExpress FS2100C.

Resource

Description

User documentation

Documents in this set: Color Printing, Configuration and Setup, Fiery Graphic Arts Pro Package,
Printing, Utilities

Online help

e Help can be accessed directly from each Fiery application or by going to help.efi.com.

e Each help system is available as a printable PDF, accessed from the PDF icon in the upper right
corner of the Help window.

Additional reference
material

e Fiery Color Reference - help.efi.com/ref/colorref/en-us/
o Variable Data Printing - help.efi.com/ref/vdp/en-us/

o Workflow Examples - help.efi.com/ref/workflows/en-us/
o  Configure Help - help.efi.com/configure/3.2.85/en-us/

e Fiery Ticker Help - help.efi.com/fieryticker/2.0/en-us/

User software for printing

You need to install user software to set up basic printing on the FS2100C Server.

Other documents may describe user software that can be used to print documents.

User software

Description

Printer drivers (for Windows and

macOS)

Provides information about the FS2100C Server and your particular printer model to
your application and printer driver.

Printer Delete Utility (for Windows) | Uninstalls the Windows printer driver and associated printer driver files. (See

Uninstall printer drivers from Windows client computers on page 16.)

Fiery Software Uninstaller Utility Uninstalls the Mac printer and associated printer driver files. (See Uninstall printer

(for macOS)

driver from a Mac computer on page 30.)



http://help.efi.com
http://help.efi.com/ref/colorref400/en-us/
http://help.efi.com/ref/vdp400/en-us/
http://help.efi.com/ref/workflows/en-us
http://help.efi.com/configure/3.2.85/cs/en-us/
http://help.efi.com/fieryticker/2.0/en-us/
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Windows for FS2100C Server

The FS2100C Server can be set up as a printer on a Windows computer by installing the printer driver for your
printer and setting up the FS2100C Server for printing.

Printer drivers provide a way to communicate information about print jobs between your applications, the FS2100C
Server, and the printer.

Installing Windows printer drivers

Installing the printer driver is the first step to set up the FS2100C Server as a printer.

You must be the administrator or a user with Administrator privileges to install printer drivers. The User Account
Control (UAC) feature is available on computers with the Windows operating systems supported by the FS2100C
Server. For information about supported operating systems, see Configuration and Setup.

Note: If the FS2100C Server printer driver is already installed, you must uninstall it before you install a new driver.
(See Uninstall printer drivers from Windows client computers on page 16.)

Installing printer drivers with Point and Print

SMB printing (also known as Windows or WINS printing) allows you to install PostScript printer drivers on your
computer from the FS2100C Server with Point and Print.

You can then print to a particular connection (Print queue, Hold queue, Direct connection or the name of the virtual
printer).

If the Sequential Print queue is enabled on the FS2100C Server, then the sequential print connection is available.

Sequential Print allows the FS2100C Server to maintain the job order on certain jobs sent from the network. The
workflow is 'First In, First Out' (FIFO), respecting the order in which the jobs were received over the network. For
more information, see Fiery Command WorkStation Help.

Each connection requires a separate installation. Repeat the procedure for each connection.

When you install the printer driver using Point and Print, you cannot configure installable options manually. The
installed options are displayed as the FS2100C Server configuration in the printer driver. (See Configure installable
options on Windows client computers on page 21.)

Before you begin, ask your administrator to do the following in Setup on the FS2100C Server:

o Assign the FS2100C Server a valid IP address.

The IP address or DNS name is required in the following procedure.
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Note: Do not use the following network IP addresses, as they are reserved for communication between the
printer and the FS2100C Server server.

e 192.168.255.xxx
e 172.16.255.xxx
e 10.255.255.xxx

e Configure the FS2100C Server for SMB printing.

Note: SMB printing is referred to as Windows Printing in Setup and on the Configuration page.

For more information, see Configure Help or Fiery Command WorkStation Help.

Set up SMB printing on Windows computers for the F$2100C Server

Install the FS2100C Server printer driver with SMB printing on Windows computers.

1 To navigate to computers and devices on your network, do one of the following:

¢ Windows Server 2019: From the desktop, click the Windows logo (Start button) in the lower-left corner of the
screen. Expand the Windows System folder and click Control Panel. Select Category in the View by drop-down
list and then click Hardware and Sound > Devices and Printers.

¢ Windows 10/Server 2016: From the desktop, click the Windows logo (Start button) in the lower-left corner of
the screen. Expand the Windows System folder and click Control Panel. Select Category in the View by drop-
down list and then click Hardware and Sound > Devices and Printers.

e Windows 8.1/Server 2012 R2: Press the Windows logo key on the keyboard to open the Start screen. From the
desktop, click the Start button in the lower-left corner of the screen. Click Control Panel and then click Devices
and Printers.

¢ Windows Server 2012: Press the Windows logo key on the keyboard to open the Start screen. Open the Search
charm by moving the mouse pointer to the upper-right or lower-right corner of the screen, move it up or
down, and click Search. Type Control Panel in the search box, click Apps, and then click Control Panel in the
results. Click Devices and Printers.

e Windows 7/Server 2008 R2: In Control Panel, click Network and Internet, and then click the View network
computers and devices link from the Network and Sharing Center list.

If you cannot locate the FS2100C Server, contact your administrator.
2 From the Start screen, type Run in the Search field.

3 Inthe Run window, type \\IP address where the IP address is for the FS2100C Server in the Open field, and click
OK.

The printer connections are displayed in Network\IP address.

Note: For a description of each print connection, see Configuration and Setup.
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Double-click the connection that you want to set up (print, hold, direct or the name of the virtual printer).

If the Sequential Print queue is enabled on the FS2100C Server, then the sequential print connection is available.

The files are installed on your computer.

Note: You may receive a message that you are about to connect to a printer on the FS2100C Server, which will
automatically install a printer driver on your computer. Click Yes to continue.

Navigate to the devices and printers on your network.

The printers are displayed in the Devices and Printers folder.
Right-click the FS2100C Server icon and choose Printer properties or Properties.

Click Print Test Page on the General tab.

If the Test Page prints successfully, you are ready to print from the computer.

Repeat the previous steps for the other connections that you want to set up.

Download printer drivers with WebTools

WebTools allow you to download printer driver installers to your computer directly from the FS2100C Server, if
your administrator has turned on access to WebTools.

For information about Setup, see Configuration and Setup.

For information about setting up and starting WebTools, see Utilities.

N =

i W

Start your Internet or intranet browser and type the DNS name or IP address of the FS2100C Server.

Expand Software Downloads.

Click the Printer Drivers link under the Windows tab.

If a dialog box prompts you to open the file or save it to disk, save it to disk.

Browse to the location where you want to save the PRNTDRV.EXE file and click Save.

The file is downloaded from the FS2100C Server. This compressed file is an archive that contains multiple files.
Double-click the PRNTDRV.EXE file to extract the files.

The extracted files will be in C:\Prntdrv folder.

After the files are copied to the specified location, the Fiery Driver Installer starts automatically.

Note: You must be the administrator or a user with Administrator privileges to install printer drivers. The User
Account Control (UAC) feature is available on computers with the Windows operating systems supported by the
FS2100C Server. Right-click PRNTDRV.EXE and select Run as administrator. For information about supported
operating systems, see Configuration and Setup.

Install the printer driver.

Follow the instructions for your operating system to install the printer driver. See Install and complete the print
connection for Windows on page 12.
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Download printer drivers from the FS2100C Server

You can download the printer driver to your computer directly from the FS2100C Server over the network, and then
follow the instructions for your operating system to install the printer driver.

The administrator must share the PC_User_SW folder over the network before you can perform the procedure. The
procedures are the same as for downloading from WebTools.

1 To navigate to computers and devices on your network, do one of the following:

Windows Server 2019: In the desktop search field, type View network computers and devices. Click Open.

Windows 10/Server 2016: In the desktop search field, type View network computers and devices. Click Open.

Windows 8.1/Server 2012 R2: Press the Windows logo key on the keyboard to open the Start screen. From the
desktop, click the Start button in the lower-left corner of the screen. Click Control Panel, click Network and
Sharing Center, and then click the View network computers and devices link from the Network and Sharing
Center list.

Windows Server 2012: Press the Windows logo key on the keyboard to open the Start screen. Open the Search
charm by moving the mouse pointer to the upper-right or lower-right corner of the screen, move it up or
down, and click Search. Type Control Panel in the search box, click Apps, and then click Control Panel in the
results. Click Network and Sharing Center. Type network in the Search field to view all options. Click the View
network computers and devices link from the Network and Sharing Center list.

Windows 7/Server 2008 R2: In Control Panel, click Network and Internet, and then click the View network
computers and devices link from the Network and Sharing Center list.

2 Search for the FS2100C Server on the network using either its name or IP address.

If you cannot locate your FS2100C Server, contact your administrator.

3 Double-click the name of the FS2100C Server.

A folder called PC_User_SW is displayed along with the active print connections.

4 Double-click the PC_User_SW folder and browse to the Print Drivers\Ps_drvr folder.

5 [Install the printer driver.

To complete the printer driver installation, follow the procedure in Install and complete the print connection for
Windows on page 12.

Install and complete the print connection for Windows

You need to install the printer driver and then complete the setup for the print connection.

When you install the printer driver and complete the print connection, you are automatically creating a local printer
(Port 9100). You can modify the port connection later, according to your network type.
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1 To install the printer driver, do one of the following:

¢ From the FS2100C Server over the network, double-click Setup in the PC_User_SW folder to start the Fiery
Driver Installer.

e From WebTools, after the printer driver is copied to the specified location, the Fiery Driver Installer starts
automatically.

2 In the Fiery Driver Installer dialog box, select the printer driver language and click Next.
The Fiery Driver Installer - InstallShield Wizard appears.
3 Click Next in the Welcome to the InstallShield Wizard for Fiery Driver Installer dialog box.
4 Read the license agreement, click | accept the terms of the license agreement and click Next.
5 For these Windows operating systems, do the following:

¢ Windows Server 2019: Click The printer that | want isn't listed.

¢ Windows 10/Server 2016: Click The printer that | want isn’t listed.

e Windows 8.1/Server 2012 R2: Click The printer that | want isn't listed.

¢ Windows Server 2012: Click The printer that | want isn’t listed.

6 Toadd alocal printer on the network, do one of the following:

¢ Windows Server 2019: Select Add a local printer or network printer with manual settings.

e Windows 10/Server 2016: Select Add a local printer or network printer with manual settings.

¢ Windows 8.1/Server 2012 R2: Select Add a local printer or network printer with manual settings.

¢ Windows Server 2012: Select Add a local printer or network printer with manual settings.

e Windows 7/Server 2008 R2: Select Add a local printer.

7 Select Create a new port, select Standard TCP/IP Port from the Type of port menu, and then click Next.
8 Do one of the following:

¢ Windows Server 2019: Type the host name or IP address of the FS2100C Server. Select the Query the printer
and automatically select the driver to use check box, and then click Next.

¢ Windows 10/Server 2016: Type the host name or IP address of the FS2100C Server. Select the Query the
printer and automatically select the driver to use check box, and then click Next.

¢ Windows 8.1/Server 2012 R2: Type the host name or IP address of the FS2100C Server. Select the Query the
printer and automatically select the driver to use check box, and then click Next.

¢ Windows Server 2012: Type the host name or IP address of the FS2100C Server. Select the Query the printer
and automatically select the driver to use check box, and then click Next.

¢ Windows 7/Server 2008 R2: Type the host name or IP address of the FS2100C Server, and then click Next.

9 In the Printers box, select your printer and click Next.

10 Type a name for the FS2100C Server in the Printer name field, and click Next.

This name is used in the Devices and Printers folder and the queues window.
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11 Follow the on-screen instructions.

Do not share the printer. Indicate whether you want to make it the default printer and do not print a Test Page at
this time.

Continue with the printer driver installation and at the last screen, click Finish.
The necessary files are installed on your hard disk drive.
12 Configure the installable options.

For more information, see Configure installable options on Windows client computers on page 21.

13 To set up a connection other than Port 9100, see Set up Standard TCP/IP Port (Raw or LPR) printing
connections on Windows client computers on page 18.

14 To use the printer driver, you must select the following options on the Advanced tab of the printer driver:

¢ Spool print documents so program finishes printing faster
¢ Start printing immediately

¢ Print spooled documents first

15 Click Apply in the FS2100C Server Properties dialog box, and then click OK.

Install and connect to a virtual printer

A virtual printer allows you to print to the FS2100C Server using a predefined set of job settings.

You do not have to set print options manually. Before you can print to a virtual printer, the administrator must
create and configure the virtual printer using Command WorkStation. After the virtual printer is set up, you can
install the printer driver and printer description files on your computer from the FS2100C Server using Point and
Print.

For more information about setting up virtual printers, see Fiery Command WorkStation Help.

When you install the printer driver with Point and Print, you cannot configure installable options manually.
Installable options are configured automatically. The installed options are displayed in the printer driver when you
select the Two-Way Communication option.

Set up a virtual printer on Windows computer with Point and Print

Complete the installation and setup of the virtual printer on a Windows computer with Point and Print.
1 To navigate to computers and devices on your network, do one of the following:

¢ Windows Server 2019: From the desktop, click the Windows logo (Start button) in the lower-left corner of the
screen. Expand the Windows System folder and click Control Panel. Select Category in the View by drop-down
list and then click Hardware and Sound > Devices and Printers.

¢ Windows 10/Server 2016: From the desktop, click the Windows logo (Start button) in the lower-left corner of
the screen. Expand the Windows System folder and click Control Panel. Select Category in the View by drop-
down list and then click Hardware and Sound > Devices and Printers.
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¢ Windows 8.1/Server 2012 R2: Press the Windows logo key on the keyboard to open the Start screen. From the
desktop, click the Start button in the lower-left corner of the screen. Click Control Panel and then click Devices
and Printers.

¢ Windows Server 2012: Press the Windows logo key on the keyboard to open the Start screen. Open the Search
charm by moving the mouse pointer to the upper-right or lower-right corner of the screen, move it up or
down, and click Search. Type Control Panel in the search box, click Apps, and then click Control Panel in the
results. Click Devices and Printers.

¢ Windows 7/Server 2008 R2: In Control Panel, click Network and Internet, and then click the View network
computers and devices link from the Network and Sharing Center list.

2 Search for the FS2100C Server on the network using either its name or IP address.

If you cannot locate the FS2100C Server, contact your administrator.

3 Double-click the FS2100C Server icon to display active print connections.

Virtual printers are listed along with the Print queue, Hold queue, and Direct connection (if those connections
are active). Virtual printers are usually assigned names that indicate the type of job for which they are set up.

If the Sequential Print queue is enabled on the FS2100C Server, then the sequential print connection is available.

4 Right-click the virtual printer that you want and select Connect.

The files are installed on your computer.

5 Navigate to the devices and printers on your network.
The virtual printer is displayed in the Devices and Printers folder.

You can print to a virtual printer as you would print to any other printer. Depending on how the virtual printer is
configured, you may not be able to set some print options.

If you use Command WorkStation to import a PostScript file to a virtual printer and the file already specifies the
number of copies, the setting for the number of copies in the PostScript file takes precedence over the number of
copies set in the virtual printer.

Note: When you print to a virtual printer installed with Point and Print, you must open the Printing Preferences
window and click OK before the job is printed. This applies the virtual printer settings to the job.

Turn on Two-Way Communication on Windows client computers

You must turn on the Two-Way Communication option to automatically update your printer driver to reflect the
options currently installed on the printer.

Note: You must be the administrator or a user with Administrator privileges to add or change the installable options
after the printer driver is installed. The User Account Control (UAC) feature is available on computers with the
Windows OS supported by FS2100C Server. (See Configure installable options on Windows client computers on
page 21.) For information about supported operating systems, see Configuration and Setup.
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Navigate to the devices and printers on your network.

¢ Windows Server 2019: From the desktop, click the Windows logo (Start button) in the lower-left corner of the
screen. Expand the Windows System folder and click Control Panel. Select Category in the View by drop-down
list and then click Hardware and Sound > Devices and Printers.

¢ Windows 10/Server 2016: From the desktop, click the Windows logo (Start button) in the lower-left corner of
the screen. Expand the Windows System folder and click Control Panel. Select Category in the View by drop-
down list and then click Hardware and Sound > Devices and Printers.

¢ Windows 8.1/Server 2012 R2: Press the Windows logo key on the keyboard to open the Start screen. From the
desktop, click the Start button in the lower-left corner of the screen. Click Control Panel and then click Devices
and Printers.

¢ Windows Server 2012: Press the Windows logo key on the keyboard to open the Start screen. Open the Search
charm by moving the mouse pointer to the upper-right or lower-right corner of the screen, move it up or
down, and click Search. Type Control Panel in the search box, click Apps, and then click Control Panel in the
results. Click Devices and Printers.

e Windows 7/Server 2008 R2: In Control Panel, click Network and Internet, and then click the View network
computers and devices link from the Network and Sharing Center list.

The printers are displayed in the Devices and Printers folder.
Right-click the FS2100C Server icon and choose Printer properties.
Click the Installable Options tab.

Select the Two-Way Communication check box.

Type the FS2100C Server IP address or DNS name.

Select Update Fiery Driver When Opened to display the current default settings for the printer when the printer
driver is opened.

Click Update.

Note: To confirm that Two-Way Communication is turned on, click the About tab and check that the FS2100C
Server name and other server information are displayed.

Click Apply, and then click OK.

You must click OK for the printer driver to reflect the correct installable options.

Uninstall printer drivers from Windows client computers

The Printer Delete Utility is installed and used locally to uninstall printer drivers from a Windows client computer.
You do not need to connect to the FS2100C Server before you use the software.

1

Install the Fiery Printer Delete Utility using WebTools.

¢ Download Printer Drivers for Windows from WebTools.

Start your Internet or intranet browser and type the DNS name or IP address of the FS2100C Server. Expand
Software Downloads. Click the Printer Drivers link under the Windows tab and follow the on-screen
instructions to install.
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Navigate to the local folder (C:\Prntdrvr) where the printer driver files were downloaded and double-click the
Fiery Printer Delete Utility folder. Double-click setup.exe and follow the on-screen instructions to install the
utility.

Click Start, select Programs or All Programs, and then select Fiery.

Select Printer Delete Utility.

Any FS2100C Server printer drivers found on your computer are listed.

Note: All printer drivers installed on your computer are listed.

In the Printer Delete Utility dialog box, do one of the following:

¢ To delete a printer, select the check box next to the printer name and click Delete the Selected Printers.

¢ To delete all of the installed printer drivers, select the Delete All Printer Drivers check box, and click OK.

When you finish deleting printer drivers, click Exit.

Setting up Windows computers for printing

After the printer driver is installed on the Windows client computer, you need to configure the proper connection

for your networked FS2100C Server printer.

To print from Windows computers, you or the administrator must perform the following tasks to set up a
connection:

Set up network servers, if any.
Set up the FS2100C Server to accept print jobs from your computer.

Configure a port on each Windows computer for the network type.

Setting up printing connections on Windows client computers

The print connections must be set up on the Windows client computers.

The FS2100C Server supports the following printing connections:

SMB

Standard TCP/IP (RAW or LPR)
IPP or IPP over SSL

FTP

WSD

17
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Set up Standard TCP/IP Port (Raw or LPR) printing connections on Windows client
computers

After you install the printer driver, you can add or configure the Setup for the Standard TCP/IP Port (Raw or LPR)
connection on a Windows client computer.

To complete the Standard TCP/IP Port (Raw or LPR) connection, do the following:

o Prepare the FS2100C Server to accept print jobs using Standard TCP/IP Port (Raw or LPR) protocols.
e Turn on LPD or Port 9100 on the FS2100C Server.

e Configure the computer for the TCP/IP connection.

For more information about Setup, see Fiery Command WorkStation Help.

Before you complete the following procedure, contact your administrator for the IP address assigned to the FS2100C
Server.

The TCP/IP protocol should be installed as a default on the Windows computer. For Port 9100, you can set up the
connection and install the printer driver in one procedure.

Note: You can also set up the LPR Port connection by installing Print Services for UNIX, which is supplied as an
add-on Windows component. For more information, see the documentation that accompanies Windows.

1 Navigate to the devices and printers on your network.

The printers are displayed in the Devices and Printers folder.
2 Right-click the FS2100C Server icon and choose Printer properties or Properties.

3 In the Ports tab, click Add Port.

To change the port settings, proceed to step 9.

4 In the Printer Ports dialog box, specify the port type in one of the following ways:
¢ Click Standard TCP/IP Port in the Available port types list, and then click New Port.
¢ Double-click Standard TCP/IP Port in the Available port types list.

5 In the Add Standard TCP/IP Printer Port Wizard dialog box, click Next.

6 Type the FS2100C Server IP address in the Printer name or IP Address text field.

7 Click Next.

8 Click Finish to close the Add Standard TCP/IP Printer Port Wizard dialog box, and then click Close in the Printer
Ports dialog box.

To change the default setting, proceed to step 9.

If you do not want to change the default setting, the setting is now completed.

Note: Port 9100 was set as the default setting in Install and complete the print connection for Windows on page
12.

9 Click Configure Port on the Ports tab of the Properties dialog box.
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10 In the Configure Standard TCP/IP Port Monitor dialog box, set up the port settings, in one of the following ways:

e To use LPR printing, select LPR in the Protocol area, and then select LPR Byte Counting Enabled in the LPR
Settings area.

Note: You can also proceed without selecting LPR Byte Counting Enabled.

e To use Port 9100 printing, select Raw in the Protocol area.

The port number 9100 automatically appears in the Raw Settings area. This is the default port number. You
can print to the printer connection selected for Port 9100 printing on the FS2100C Server.

To specify a specific port number, see step 11.

11 Type the name of the print connection.
For LPR, type print, hold, direct or sequential for Queue Name or published virtual printer name.
For Port 9100, type the following port numbers for each print connection in the Raw Settings area:
e FS2100C Server default: 9100
e direct: 9101
e print: 9102
¢ hold: 9103

Note: Type the number exactly as shown.

12 When the SNMP Status Enabled check box is selected, spooling is stopped if the printer driver or spooler detects
an error status on the FS2100C Server.

13 Click OK to close the Configure Standard TCP/IP Port Monitor dialog box.

Note: The FS2100C Server supports printing in the IPv6 environment on Windows operating systems. For
information about supported operating systems, see Configuration and Setup.

14 Click Apply in the FS2100C Server Properties dialog box, and then click OK.

Complete IPP connections on Windows client computers

With Internet Printing Protocol (IPP), print jobs are sent to the FS2100C Server over the Internet from Windows
computers.

Before you begin, perform the following tasks:

e Make sure that the FS2100C Server is configured for TCP/IP printing and IPP printing. (See Command
WorkStation Help.)

o Specify the printing destination on your computer.
IPP over SSL connections is supported.
Note: Using IPP over SSL connection requires certificates on Windows operating systems. For information about

supported operating systems and on certificate creation, see Configuration and Setup. You can manage certificates
from Configure. (See Command WorkStation Help.)
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1 Navigate to the devices and printers on your network.

The printers are displayed in the Devices and Printers folder.

2 To add a printer, do one of the following:
¢ Click Add a printer, and then select Add a network, wireless, or Bluetooth printer or Add a network printer.
¢ Double-click the Add Printer icon, click Next, and then select Network printer and click Next.

3 To search for a printer on the network, do one of the following:

¢ Windows Server 2019: If the printer search takes a long time, click The printer that | want isn't listed.

e Windows 10/Server 2016: If the printer search takes a long time, click The printer that | want isn’t listed.

¢ Windows 8.1/Server 2012 R2: If the printer search takes a long time, click Stop, and then click The printer that |
wantisn’t listed.

¢ Windows Server 2012: If the printer search takes a long time, click Stop, and then click The printer that | want
isn't listed.

¢ Windows 7/Server 2008 R2: If the printer search takes a long time, click Stop, and then click The printer that|
want isn't listed.

4 To connect to a printer on the network, do one of the following:

¢ Windows Server 2019: Click Select a shared printer by name, and in the URL field, type the IP address or DNS
name of the FS2100C Server, followed by the name of the connection (print, hold, or direct).

For example, http://10.10.10.150/ipp/print or http://DNS name of server/ipp/print sends the job to the
Print queue on the FS2100C Server.

Note: The URL for the printer is not case-sensitive.

e Windows 10/Server 2016: Click Select a shared printer by name, and in the URL field, type the IP address or
DNS name of the FS2100C Server, followed by the name of the connection (print, hold, or direct).

For example, http://10.10.10.150/ipp/print or http://DNS name of server/ipp/print sends the job to the
Print queue on the FS2100C Server.

Note: The URL for the printer is not case-sensitive.

¢ Windows 8.1/Server 2012 R2: Click Select a Shared printer by name, and in the URL field, type the IP address
or DNS name of the FS2100C Server, followed by the name of the connection (print, hold, or direct).

For example, http://10.10.10.150/ipp/print or http://DNS name of server/ipp/print sends the job to the
Print queue on the FS2100C Server.

Note: The URL for the printer is not case-sensitive.
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¢ Windows Server 2012: Click Select a Shared printer by name, and in the URL field, type the IP address or DNS
name of the FS2100C Server, followed by the name of the connection (print, hold, or direct).

For example, http://10.10.10.150/ipp/print or http://DNS name of server/ipp/print sends the job to the
Print queue on the FS2100C Server.

Note: The URL for the printer is not case-sensitive.

¢ Windows 7/Server 2008 R2: Click Select a Shared printer by name, and in the URL field, type the IP address or
DNS name of the FS2100C Server, followed by the name of the connection (print, hold, or direct).

For example, http://10.10.10.150/ipp/print or http://DNS name of server/ipp/print sends the job to the
Print queue on the FS2100C Server.

Note: The URL for the printer is not case-sensitive.

5 Click Next.

6 To install the printer driver, do one of the following:

¢ Windows Server 2019: Select the manufacturer and model of your printer and click OK.

¢ Windows 10/Server 2016: Select the manufacturer and model of your printer and click OK.

e Windows 8.1/Server 2012 R2: Click Install driver.

e Windows Server 2012: Click Install driver.

e Windows 7/Server 2008 R2: Click Install driver.

7 Ifyou are installing the PostScript printer for the first time, follow the procedure Install and complete the print
connection for Windows on page 12.

8 Indicate whether you want to make the FS2100C Server the default printer.

¢ Windows Server 2019: Click Finish.

e Windows 10/Server 2016: Click Finish.

e Windows 8.1/Server 2012 R2: Click Next.

o Windows Server 2012: Click Next.

* Windows 7/Server 2008 R2: Click Next.

9 To complete the printer driver installation, click Finish.

Configure installable options on Windows client computers

After you complete the printer driver installation, you must configure the FS2100C Server for the options installed
on the printer to allow the FS2100C Server to take advantage of the printer options.

Configure the options manually, or for TCP/IP network connections, use the Two-Way Communication option to
configure the options automatically.

Note: When you configure installable options manually, make sure to leave Two-Way Communication and Update
Fiery Driver When Opened options unchecked.

For information about specifying installable options, see printer driver help.
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Note: The User Account Control (UAC) feature is available on computers with the Windows operating systems
supported by the FS2100C Server. You must log on with Administrator privileges to add or change the installable
options after the printer driver is installed. For more information about supported operating systems, see
Configuration and Setup.

1 Navigate to the devices and printers on your network.

The printers are displayed in the Devices and Printers folder.

2 For Windows computers with User Account Control, right-click the FS2100C Server icon, select Run as
administrator, and then select Printer properties.

The User Account Control dialog box opens.

Select the User that has administrator privileges, type the password, and then click OK.

H W

Right-click the FS2100C Server icon and choose Printer properties.

V)]

Click the Installable Options tab and make your selections.

6 Click Apply, and then click OK.

You must click OK for the printer driver to reflect the correct installable options.

Configure installable options for Windows 10 or later printer drivers

After you complete the printer driver installation, you can also configure the options installed on the printer for
Windows 10 or later in Settings.

1 Click the Windows logo (Start button).
Click Settings > Devices, and then select Printers & Scanners.
Select the FS2100C Server from the list.

2

3

4 C(Click Manage, and then click Printer properties.

5 Click the Installable Options tab and make your selections.
6

Click Apply, and then click OK.

You must click OK for the printer driver to reflect the correct installable options.

Configure installable options for printer drivers installed with the Add Printer Wizard on Windows
client computers
After you install the printer driver, you must configure the installable options.

If you install the printer driver from Add Printer Wizard and then use Two-Way Communication to configure the
installable options, the installable options are not configured properly.

1 After you install the printer driver, right-click the FS2100C Server icon, select Printer properties, click the
Installable Options tab, and then select your installable options.

2 Click Apply, and then click OK.

You must click OK for the printer driver to reflect the correct installable options.

22
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Printing from Windows client computers

You can print to the FS2100C Server just as you would print to any other printer from a Windows application.

You can print from a networked Windows computer or a computer using Windows (WINS) printing. Select the
FS2100C Server as the current printer in the Printer Name list, specify print options, and then print the document
from the application.

The following list includes other methods to print to the FS2100C Server and describes where to find information
about these features:

Downloading files to the FS2100C Server with the Docs tab in WebTools. (See Utilities.)

e Printing documents with E-mail Services. (See E-mail Service on page 39.)

o Printing documents with Fiery Hot Folders. (See Fiery Hot Folders Help or Utilities.)

e Printing documents with Command WorkStation. (See Fiery Command WorkStation Help.)

e Printing documents on the USB flash drive to the FS2100C Server. (See Printing from a USB flash drive on page
41.)

e Printing documents with Web Services Device (WSD) printing. (See Web Services for Devices printing on page
48.)

The following list includes information about printing and saving files to the FS2100C Server and describes where to
find information about these features:

e Achieving optimal printing results from applications. (See Color Printing and Fiery Color Reference.)
o DPrinting jobs from Windows applications. (See Print jobs from Windows applications on page 23.)

o Specifying default print options. (See Specify default print options for print jobs on Windows client computers
on page 27.)

o Customizing the Quick Access icon. (See Customize the Quick Access icon in the Windows printer driver on
page 27.)

e Viewing the printer status. (See View the printer status on page 28.)

o Saving files to print to a remote location. (See Saving files to print at a remote location on page 28.)

Print jobs from Windows applications

To print from Windows applications, install the PostScript printer driver, and then specify print options for a
particular job before sending it to the FS2100C Server for printing.

Be sure to configure the options on the Advanced tab of the printer driver after installation is complete. (See
Installing Windows printer drivers on page 9.)

If you print to a virtual printer, you may not be able to set some print options, depending on how the virtual printer
is configured.

Some print options that are selectable from an application are similar to print options that are specific to the
FS2100C Server and the printer. In these cases, use the print options specific to the FS2100C Server and the printer.
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These options appear on the Fiery Printing tab. The application may not set up the file properly for printing on the
FS2100C Server, resulting in unexpected finishing, printing errors, or longer processing time.

If you specify incompatible print settings when printing a document, the Conflict dialog box provides instructions to
resolve the conflict.

Some print options, such as Paper Catalog and VDP master information, are available only if Two-Way
Communication is turned on or a particular installable option is configured. For information about Two-Way
Communication, see printer driver help. (See Configure installable options on Windows client computers on page
21.)

If you select Printer’s default, the job prints according to the settings that the administrator specified in Setup. (See
Print options and default settings on page 51.)

Set print options for a specific print job with the Windows printer driver

After you install the Windows printer driver on the client computer, you can set print options for a print job.
1 In your application, select File > Print, and select the FS2100C Server as your printer.

2 Click Printing Preferences or Properties.

3 Click the Fiery Printing tab.
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The Fiery Printing tab serves as the control center for all frequently used printing functions.

When you save the print options in a preset, the following option settings are not reflected:

¢ Job Info options: Destination > Destination and Schedule printing, Job notes > Secure print, User

authentication > Password

e Layout option: Impose

Note: The Impose option is only accessible from Command WorkStation Job Properties.

For information about using presets, see printer driver help.

Note: For a list of print options, see Print options and default settings on page 51.

4 Specify print options and settings for your job.

25
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The print options are grouped by categories. Each group or tab contains print options that are similar or
complement one another.

Quick Access- Contains duplicate print options from the other job properties groups. It is customizable, so any
print option can be added or removed from the view. The Quick Access tab lets you find print options quickly
without browsing through all of the Job Properties tabs. (See Customize the Quick Access icon in the Windows
printer driver on page 27.)

Job Info- All information about the job, including user information that may be required for user
authentication and job handling. (See Job Info options on page 52.)

Media- Attributes and sources of paper to print and insert. (See Media options on page 55.)

Layout- Defines the imposition of the print job and the booklet process on the media/sheet, except for
positioning that compensates for finishing options, for example, Tray Alignment. (See Layout options on page
57.)

Color- Color settings and additional features (when optional color features are turned on). (See Color options
on page 69.)

Image- All image quality settings supported by the connected FS2100C Server and printer. (See Image options
on page 76.)

Finishing- Print options related only to finishing equipment on the printer, and also image shifting to
compensate for finishing options. These options override settings in FS2100C Server Setup but can be changed
from Command WorkStation. (See Finishing options on page 78.)

VDP- All Variable Data Printing (VDP) settings, such as FreeForm and advanced VDP settings. (SeeVariable
Data Printing (VDP) options on page 85 .)

Stamping- All image stamping options that add or hide/remove any image on the job. This also includes
watermark properties that define the placement and style of the watermark. (See Stamping (Watermark)
options on page 87 or printer driver help.)

Tools- All Fiery applications supported by the connected FS2100C Server. (See Open Fiery applications in the
printer driver on page 28 or printer driver help)

Printer- Information about printer status that includes the current paper and toner or ink levels. (See View the
printer status on page 28 or printer driver help.)

After you specify the print settings, click OK, and then click Print to send your print job.

Note: When you use the Enable job tracking print option, a window is displayed for your job accounting
information.
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Specify default print options for print jobs on Windows client computers

You can set the default print options for Windows print jobs using the Windows printer driver.

1 Navigate to the devices and printers on your network.

Windows Server 2019: Press the Windows button on the keyboard to open the Start screen. From the desktop,
right-click the Start button in the lower-left corner of the screen. Click Control Panel. Click Hardware and
Sound and then click Devices and Printers.

Windows 10/Server 2016: Press the Windows button on the keyboard to open the Start screen. From the
desktop, right-click the Start button in the lower-left corner of the screen. Click Control Panel. Click Hardware
and Sound and then click Devices and Printers.

Windows 8.1/Server 2012 R2: Press the Windows button on the keyboard to open the Start screen. From the
desktop, click the Start button in the lower-left corner of the screen. Click Control Panel and then click Devices
and Printers.

Windows Server 2012: Press the Windows button on the keyboard to open the Start screen. Open the Search
charm by moving the mouse pointer to the upper-right or lower-right corner of the screen, move it up or
down, and click Search. Type Control Panel in the search box, click Apps, and then click Control Panel in the
results. Click Devices and Printers.

Windows 7/Server 2008 R2: In Control Panel, click Network and Internet, and then click the View network
computers and devices link from the Network and Sharing Center list.

The printers are displayed in the Devices and Printers folder.

Right-click the FS2100C Server icon and select Printing preferences.

Click the Fiery Printing tab.

Specify the default settings for your print job. (See Set print options for a specific print job with the Windows
printer driver on page 24.)

Click OK to close the dialog box.

Customize the Quick Access icon in the Windows printer driver

The Quick Access icon can be customized with print options that you use frequently.

This saves time because you do not have to open all of the other print option icons to set the options that you placed
in Quick Access.

When you place a print option in Quick Access, it still appears under its original print option icon. You can set the
option from either location.

1

2

w

In your application, select File > Print and select the FS2100C Server as your printer.

Click Properties.

Click the Fiery Printing tab, if necessary.

Click Customize to specify the options shown in the Customize Quick Access dialog box.
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5 Add or remove a shortcut by selecting one and moving it from the Available Shortcuts list to/from the Current
Shortcuts list.

6 Click OK to save your changes.

For more information about Quick Access, see printer driver help.

Fiery Driver Updater

The Fiery Driver Updater notification is displayed by the default setting. When updates are available, the Fiery Driver

Updater notification window opens. You can update the printer driver by clicking the Update button.

You can also start the Fiery Driver Updater by clicking Check for driver update on the About tab of the Printer
Properties window.

If you prefer to have automatic notification for updates turned off, do the following procedure.
1 Start the Fiery Driver Updater.

2 Click the settings icon at the bottom left corner of the Fiery Driver Updater window.

3 Clear the Show notifications option in the Preferences window.

Note: The Fiery Driver Updater updates the Fiery core driver only.

Open Fiery applications in the printer driver

You can retrieve the supported Fiery applications from the FS2100C Server and display them in the printer driver
with the Two-Way Communication option.

In the printer driver, navigate to the Tools tab and click Launch to open your preferred Fiery applications.

View the printer status

You can retrieve the status and levels of consumable materials of the printer from the FS2100C Server and display
them in the printer driver with the Two-Way Communication option.

You can retrieve its color settings from the FS2100C Server and display them in the printer driver.

For information about monitoring the status of the printer, see printer driver help.

Saving files to print at a remote location

If you do not have the FS2100C Server on site and are preparing files for a service bureau or other location, print the
final files to the File port (as opposed to one of the local ports).

You can also print to the File port to create a file to download using the Docs tab in WebTools. For instructions on
printing to the File port, see the documentation that accompanies Windows.
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macOS for FS2100C Server

The FS2100C Server can be set up as a printer on a Mac computer by installing the printer driver for your printer
and setting up the FS2100C Server for printing.

Printer drivers provide a way to communicate information about print jobs between your applications, the FS2100C
Server, and the printer.

For a complete list of supported Mac operating systems, see Configuration and Setup.

Installing printer driver on a Mac computer

Installing the printer driver is the first step to set up the FS2100C Server as a printer.

Note: If the FS2100C Server printer driver is already installed, you must uninstall it before you install a new driver.
(See Uninstall printer driver from a Mac computer on page 30.)

Download printer drivers with WebTools

WebTools allow you to download printer driver installers to your computer directly from the FS2100C Server, if
your administrator has configured access to WebTools.

For more information about setting up and starting WebTools, see Utilities.

1 Start your Internet or intranet browser and type the DNS name or IP address of the FS2100C Server.
2 Expand Software Downloads.

3 Click the Printer Drivers link under the Mac OSX tab.

A file named Fiery Printer Driver.dmg is downloaded to your desktop.

Note: If the file is not on the desktop, open the Downloads folder.

Double-click Fiery Printer Driver.dmg.

Double-click Fiery Printer Driver.pkg and click Continue.

Read the license and click Continue.

N & u b

Follow the on-screen instructions.

The Fiery Printer Driver Installer installs the printer driver that correspond to the FS2100C Server.

Note: When the printer driver is added with the Bonjour connection, the last three bytes of the Mac address is
added to the FS2100C Server name.
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If you can find the FS2100C Server from the list of printers by Network Discovery, do one of the following:

¢ Select the FS2100C Server, and continue to install the printer driver by specifying the Print queue. The printer
uses the Bonjour connection.

¢ Select the FS2100C Server, and continue to install the printer driver by specifying the Hold queue. The printer
uses the LPD (LPR) protocol.

If you cannot find the FS2100C Server (on a different subnet) and you want to use Port9100/LPR/ipp or want to
connect to a virtual printer, then click Install Printer Driver Only.

You need to associate the printer driver from System Preferences > Printers & Scanners with the FS2100C Server.

Download the Mac printer driver from the FS2100C Server

You can download the printer driver to your Mac computer directly from the FS2100C Server over the network.

1

N

In the Finder, select Go > Connect to Server.

Type SMB:// followed by the name or IP address of the FS2100C Server and click Connect.

If you cannot locate your FS2100C Server, contact your administrator.

Type the user name and password in the SMB/CIFS File System Authentication dialog box.

The “Guest” account can be used as the default. The Guest account does not require a password. If the Guest
account cannot be used, ask your network administrator for an account.

Select the Mac_User_SW folder from the shared volume list and click OK.
Double-click the Fiery Printer Driver Installer icon to start installing the printer driver.

Follow the on-screen instructions.

Uninstall printer driver from a Mac computer

The Fiery Software Uninstaller utility is used to remove printer drivers from the Mac computer. It is installed and
used locally on your Mac computer.

Install and use the Fiery Software Uninstaller utility

1

To copy the Fiery Software Uninstaller.dmg to your desktop, do the following:

¢ Double-click Fiery Printer Driver.dmg inside the Mac_User_SW folder from the shared volume list on the
FS2100C Server and copy Fiery Software Uninstaller.dmg.

Double-click Fiery Software Uninstaller.dmg.

The Fiery Software Uninstaller opens in the Finder, displaying the Fiery Software Uninstaller icon and an arrow
pointing to a link to the Applications folder.

Drag the Fiery Software Uninstaller icon to the Applications folder.
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4 Open the Applications folder and double-click the Fiery Software Uninstaller icon.
5 Click the Printers tab if it is not already selected.

6 Select a printer from the Installed Printers list.

7 Do one of the following:

¢ Click Remove Printer and Driver to remove the printer along with its printer driver files.

If you want to remove the printer and the associated printer driver files, you can select only one printer at a
time.

¢ Click Remove Printer to remove the printer from the Installed Printers list only, but leave the printer driver files
installed.

The utility can remove only printers that are not currently in use or open on the Dock.

Note: If more than one printer uses the same printer driver file, removing the printer driver file also removes all
printers using that printer driver.

8 To confirm that you want to delete the printer, type the password for your Mac computer in the dialog box and
click OK.

9 Click the Drivers tab to view the installed printer drivers.

10 Close the Fiery Software Uninstaller dialog box.

Delete the Fiery Software Uninstaller utility

+ Delete the Fiery Software Uninstaller icon from the Applications folder.

Set up Mac computers for printing

After the printer driver that corresponds to your printer has been installed, you must set up the Mac computer for
printing to the FS2100C Server.

Set up printing on a Mac client computer

After you have the FS2100C Server printer driver installed, you must set up printing to the FS2100C Server on a
client computer running macOS. You can add the printer with the LPR, Port 9100 or IPP connection.

Set up the FS2100C Server from the Print dialog box on a Mac client computer

1 Open a file in your application.

2 Select File > Print.
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Select Add Printer from the Printer menu.
In the dialog box that appears, select one of the printer connections:

e Default

e |IP

Set up the FS2100C Server with Printers & Scanners on a Mac client computer

1
2

Select Apple menu > System Preferences, and then select Printers & Scanners.
Click the + button to add a Printer. In the dialog box that appears, select one of the printer connections:

e Default

o IP

Add a printer with the Default connection on a Mac client computer

You can add a printer with the Default connection on a Mac client computer.

1

Click the Default icon in the upper-left corner of the Add dialog box.

Virtual printers are listed along with the default printer connections. Virtual printers appear as printer name :
virtual printer name in the list of printers.

Any published virtual printer is available over SMB, LPR, and FTP.

In the Default pane, select the FS2100C Server from the list.

The information about the selected printer appears at the bottom of the Default pane. The appropriate printer
driver for the FS2100C Server is automatically selected.

Click Add.
The FS2100C Server name appears in the list of printers.

Select FS2100C Server.
Click Options & Supplies, and then click the Options tab.

Specify the installable option settings, and then click OK.

For information about configuring installable options, see printer driver help.

Obtain the IP address of the FS2100C Server on a Mac client computer

When the Bonjour connection is used for the FS2100C Server printer driver on a Mac client computer, you can find
out the IP address of the FS2100C Server from the printer’s Webpage.

The IP address can also be found from the Fiery QuickTouch LCD on the FS2100C Server, by tapping the lower left
corner or the Fiery logo in the upper left corner to view information about the FS2100C Server.



H W N

Printing 33
macOS for FS2100C Server

Select Apple menu > System Preferences, and then select Printers & Scanners.
Select the FS2100C Server from the list, and then click Options & Supplies.
Click the General tab, and then click Show Printer Webpage.

Click the Configure tab.

Scroll to Network, locate the IP address for the FS2100C Server, and record it for future reference.
The IP address is needed to turn on Two-Way Communication in the printer driver.

For information about Two-Way Communication, see printer driver help.
Click the Close button to exit WebTools.
Click OK to close the Options & Supplies pane.

Close the Printers & Scanners dialog box.

Add a printer with the IP Printer connection on a Mac client computer

You can add a printer with the IP Printer connection on a Mac client computer.

1
2
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Click the IP icon in the upper-left corner of the Add dialog box.
In the IP pane, do one of the following:

e For LPD printing, select Line Printer Daemon - LPD from the Protocol list, type the FS2100C Server IP address
or DNS name in the Address field, and then type the print connection (print, hold or sequential) or published
virtual printer name in the Queue field.

e For Port 910x printing, select HP Jetdirect - Socket from the Protocol list, type the FS2100C Server IP address
or DNS name in the Address field. The Queue field can be left empty.

Choose Select Software from the Use menu.

Locate the printer manufacturer or model in the list, select the printer driver, and then click OK.
Click Add.

Specify the installable option settings in the installable options pane in the Printers & Scanners dialog box, and
then click OK.

The FS2100C Server with its IP address appears in the list of printers.

For information about configuring installable options, see printer driver help.

Configuring installable options on Mac client computers

To use the print options for the printer and FS2100C Server appropriately, you must configure the FS2100C Server
from your computer for the options that are installed on the printer. Configure the options manually.

For information about configuring installable options, see printer driver help.



Printing
macOS for FS2100C Server

Using Desktop Printer

After adding the FS2100C Server to the list of printers in the Printers & Scanners dialog box, you can create and use
the Desktop Printer feature.

For information about the Desktop Printer feature, see printer driver help.

Printing from Mac client computers

You can print to the FS2100C Server just as you would print to any other printer from a Mac application.

Select the FS2100C Server as the default printer in the list of printers, specify print options, and then print the
document from the application.

The following list includes other methods to print to the FS2100C Server and describes where to find information
about these features:

Downloading files to the FS2100C Server with the Docs tab in WebTools. (See Utilities.)

Printing documents with Fiery Hot Folders. (See Fiery Hot Folders Help or Utilities.)
e Printing documents with Command WorkStation. (See Fiery Command WorkStation Help.)
o Achieving optimal printing results from applications. (See Color Printing and Fiery Color Reference.)

o Selecting the FS2100C Server in the Printers list. (See Select the FS2100C Server as the default printer on a Mac
client computer on page 34.)

e Printing jobs from Mac applications. (See Set print options and printing from Mac applications on page 35.)

o Customizing the Quick Access view. (See Customize the Quick Access pane in the Mac printer driver on page
37.)

e Viewing the printer status. (See View the printer status on page 38.)

Select the FS2100C Server as the default printer on a Mac client computer
Before you print a job, you must set the FS2100C Server in the Printers list as your default printer.
1 Make sure that the FS2100C Server is connected to the network and turned on.

2 Select Apple menu > System Preferences, and then select Printers & Scanners.

The printers that are set up for printing are listed. The virtual printers that are configured at the FS2100C Server
and set up for printing are also listed.

3 Select FS2100C Server from the Default Printer menu.

4 Close the window.
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View queries in the Print Queue on client computers

When the printer driver establishes communication with the FS2100C Server on a Mac client computer, the queries
are listed as jobs in the Print Queue.

To view the queries, open the Print Queue.

« Select Apple menu > System Preferences > Printers & Scanners, then select the FS2100C Server from the list of
printers, and click Open Print Queue.

The queries are not real jobs and they will disappear from the Print Queue after they are completed.

Set print options and printing from Mac applications

To print from Mac client computers, install the printer driver for your printer.

In Mac applications, print options are set from the Print dialog box. (See Installing printer driver on a Mac computer
on page 29.)

Some print options that are selectable from an application are similar to print options that are specific to the
FS2100C Server and the printer. In these cases, use the print options specific to the FS2100C Server and the printer.
These options appear in the Fiery Features pane and/or in the Printing Preferences window. The application may not
set up the file properly for printing on the FS2100C Server, resulting in unexpected finishing, printing errors, or
longer processing time.

If you specify incompatible print settings when printing a document, the Conflict dialog box provides instructions to
resolve the conflict.

Some print options are available only if Two-Way Communication is turned on or a particular installable option is
configured.

You can retrieve its color settings from the FS2100C Server when Two-Way Communication is turned on and
display them in the printer driver.

For information about Two-Way Communication, see printer driver help. (See Configuring installable options on
Mac client computers on page 33.)

If you select Printer’s default, the job prints according to the settings that the administrator specified in Setup. (See
Set print options and print a job from a Mac client computer on page 35.)

Set print options and print a job from a Mac client computer

You use the printer driver to specify print options for a particular job and then print it to the FS2100C Server.

1 Inyour application, select File > Print, and select the FS2100C Server as your printer.

2 Select Fiery Features from the drop-down list.
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Print
Printer:  Aero ﬁ
Presets: Standard ﬂ

Copies: 1
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1 Fiery Features

2 Customize (Shortcuts), see Help

3 Full Properties

4 Presets (Job Templates), see Help

5 Two-Way Communication
Note: The Fiery Features option is not displayed in the macOS Mojave 10.14 Print dialog box for native
applications, such as Safari, Preview, TextEdit, Pages, Numbers, and Keynote. Instead, the Printer Features option
will be displayed and the printer driver can be used with limited options for printing. To print from these native
applications, you can use Command WorkStation to print the job with Paper Catalog, Mixed media, and Booklet

Maker or save the job as a PDF file and use any of the Adobe Acrobat applications, such as Reader, to open Fiery
Features.

When you save the print options in a preset, the following option settings are not reflected:

¢ Job Info options: Destination > Destination and Schedule printing, Job notes > Secure print, User
authentication > Password

¢ Layout option: Impose
Note: The Impose option is only accessible from Command WorkStation Job Properties.

For information about using presets, see printer driver help.

For a list of print options, see Print options and default settings on page 51.

3 Click Full Properties in the Quick Access pane to specify print options and settings for your job.
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The print options are grouped by categories. Each group or tab contains print options that are similar or
complement one another.

Quick Access- Contains duplicate print options from the other job properties groups. It is customizable, so any
job override print option can be added or removed from the view. The Quick Access pane lets you find print
options quickly without browsing through all of the Job Properties tabs. (See Customize the Quick Access icon
in the Windows printer driver on page 27.)

Job Info- All information about the job, including user information that may be required for user
authentication and job handling. (See Job Info options on page 52.)

Media- Attributes and sources of paper to print and insert. (See Media options on page 55.)

Layout- Layout defines the imposition of the print job and the booklet process on the media/sheet, except for
positioning that compensates for finishing options, for example, Tray Alignment. (See Layout options on page
57.)

Color- Color settings and additional features (when optional color features are turned on). (See Color options
on page 69.)

Image- All image quality settings supported by the connected FS2100C Server and printer. (See Image options
on page 76.)

Finishing- Print options related only to finishing equipment on the printer, and also image shifting to
compensate for finishing options. These options override settings in FS2100C Server Setup but can be changed
from Command WorkStation. (See Finishing options on page 78.)

VDP- All Variable Data Printing (VDP) settings, such as FreeForm and advanced VDP settings. (SeeVariable
Data Printing (VDP) options on page 85 .)

Stamping- All image stamping options that add or hide/remove any image on the job. This also includes
watermark properties that define the placement and style of the watermark. (See Stamping (Watermark)
options on page 87 or printer driver help.)

Tools- All Fiery applications supported by the connected FS2100C Server. (See Open Fiery applications in the
printer driver on page 38 or printer driver help)

Printer- Information about printer status that includes the current paper and toner or ink levels. (See View the
printer status on page 38 or printer driver help.)

4 After you specify the print settings, click OK, and then click Print to send your print job.

Note: When you use the Enable job tracking print option, a window is displayed for your job accounting
information.

Customize the Quick Access pane in the Mac printer driver

The Quick Access pane can be customized with print options that you use frequently.

This saves time because you do not have to open all of the other print option icons to set the options that you placed
in Quick Access.

When you place a print option in Quick Access, it still appears under its original print option icon. You can set the
option from either location.

1 Inyour application, select File > Print and select the FS2100C Server as your printer.
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2 Select Fiery Features from the drop-down list.
3 Click Customize to specify the options shown in the Quick Access pane.

4 Add or remove a shortcut by selecting one and moving it from the Available Shortcuts list to/from the Current
Shortcuts list.

5 Click OK to save your changes.

For more information about Quick Access, see printer driver help.

Open Fiery applications in the printer driver

You can retrieve the supported Fiery applications from the FS2100C Server and display them in the printer driver
with the Two-Way Communication option.

In the printer driver, navigate to the Tools tab and click Launch to open your preferred Fiery applications.

View the printer status

You can retrieve the status and levels of consumable materials of the printer from the FS2100C Server and display
them in the printer driver with the Two-Way Communication option.

You can retrieve its color settings from the FS2100C Server and display them in the printer driver.

For information about monitoring the status of the printer, see printer driver help.
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Other Printing Methods

You can print jobs with the FS2100C Server printer driver to the FS2100C Server, as well as other printing methods,
such as Command WorkStation.

E-mail Service

E-mail Service allows you to control the FS2100C Server using your current email infrastructure, print to remote
locations, and bypass firewalls.

E-mail Service is not application-specific. You can use any email infrastructure.

The FS2100C Server supports internal address books. Administrators can retrieve, add, delete, and clear addresses
from address books by sending requests through email. (See Configuration and Setup.)

To set up E-mail Service, see Configure Help.

Use E-mail Service in the following ways:

e DPrint ajob from an email application.

To print with an email client, you send a file as an email attachment. E-mail Service extracts the file and sends it
to the FS2100C Server. The attachment can be in any file format the FS2100C Server recognizes (PS, PDF, EPS,
VDP, or TIFF).

Note: E-mail Service does not process files with .vbs, .exe, or .bat extensions.

You can print Microsoft Office files (Word, Excel, Publisher, and PowerPoint) from an email application if
Enable Native Document conversion using PrintMe is selected in Configure > RIP > Native Documents.

e Manage jobs using an email application.
You can manage your print jobs by submitting email commands to the FS2100C Server using email.
e Scan to E-mail.

You can scan a document and send it to an email address as an attachment or URL. (See Utilities.)

Printing using an email client

You can submit print jobs to the FS2100C Server in the form of an email attachment using your email application.

When you send an email with an attachment, E-mail Service extracts the file and sends it to the FS2100C Server
Print queue. The file format must be one supported by the FS2100C Server.

By default, anyone can print with an email client, unless the Print address book has been set up by the administrator.
If the Print address book has been set up and your email address is not in it, you cannot send files to the FS2100C
Server using email. (See Configuration and Setup.)
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When User Authentication is turned on at the FS2100C Server, the email attachment must have the appropriate user
name and password when it is printed through email printing. As part of creating the email attachment with the
FS2100C Server printer driver, type the appropriate user name and password on the Job Info tab of the printer
driver. The user name and password must match those defined by the administrator in the Users and Groups section
of Configure. For information about Users and Groups, see Command WorkStation Help.

Note: The Direct connection is not supported by the email client feature.

When the attached job is printed, the email is also printed, which includes the typical header information, such as
subject, date, sender, and so forth.

Print an email attachment with an email client

You can print an email attachment with an email client.

1 Open your email application.

2 Type the FS2100C Server email address in the To: line.

3 Type text in the Subject line or leave the Subject line blank.
4 Attach the file that you want to print.

The attachment can be in any file format the FS2100C Server recognizes (PS, PDF, EPS, VDP, or TIFF).

You can also print Microsoft Office files (Word, Excel, Publisher, and PowerPoint) from an email application if
Enable Native Document conversion using PrintMe is selected in Configure > RIP > Native Documents.

Note: If your attachment exceeds the file size limitation set by your email administrator, the email is not sent.
5 To identify the job or provide further processing instructions, type text in the body of the message.

Note: HTML-formatted email messages are not supported, and might not print as they appear on the remote
workstation. Send email messages in plain text format.

6 Send the email.

The file is sent to the FS2100C Server and the job is printed. After the FS2100C Server receives the job, you
receive an email notification that the print job was accepted. The email provides a job identification (ID). Use job
IDs to manage jobs with email commands. The email notification indicates any current error at the printer. (See
Manage print jobs with email commands on page 40.)

After the job is printed, you receive a second email notification that indicates the job printed successfully.

Manage print jobs with email commands

You can manage your print jobs by submitting commands to the FS2100C Server using email.

You can cancel a job, check job status, and get help on a job. When you send a command, the FS2100C Server sends
an email response.

1 In your email application, type the FS2100C Server email address in the To: line.
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2 Type one of the following commands in the Subject line:

e To check the status of a job, type #JobStatus<job id> in the Subject line.

You receive a reply to your job status query. You can only get the status of the job if you sent the job or are an
administrator.

e To cancel a job, type #CancelJob<job id> in the Subject line.

You receive a notification indicating that the job has been canceled and did not print to the FS2100C Server.
You can only cancel a job if you sent the job.

e To get help, type #Help in the Subject line.

You receive an email response that contains links that allow you to cancel jobs, check job status, and search
and manage address books. Click any of the links to perform a command.

3 Send the email to the FS2100C Server.

Printing from a USB flash drive

You can print files from a USB flash drive to the FS2100C Server. The FS2100C Server supports printing from the
USB flash drive using USB Media Server.

The USB port and automatic printing feature must be enabled in Configure, as described in Configuration and Setup
or Command WorkStation Help.

You can manually print files from a USB flash drive when USB Media Autoprint is disabled in Configure.

Files are automatically processed as soon as you connect the USB flash drive to the FS2100C Server. The files can be
from Mac or Windows computers, and can be any of the supported file types (EPS, PCL, PDF, PS, or TIFF).

Note: You can print Microsoft Office files (Word, Excel, Publisher, and PowerPoint) from a USB flash drive if Enable
Native Document conversion using PrintMe is selected in Configure > RIP > Native Documents.

You can set up folders in the root of the flash drive to correspond to the FS2100C Server queues:

e To send files to one of the standard print queues (print, hold, or direct) on the FS2100C Server, create folders
with those names in the root of the flash drive, and then drop the files into the folders.

e To print any file from the USB flash drive, manually select the file to print, specify where to send it, and select
print options.

o Files in folders with FS2100C Server queue names at the root level of the USB flash drive are copied
automatically to the corresponding FS2100C Server queue.

e To send files to a virtual printer that is configured on the FS2100C Server, create a folder with the virtual printer
name in the root of the flash drive, and then drop the files into the folder. Verify with your administrator that the
virtual printers are published. For more information about virtual printers, see Command WorkStation Help.

Note: If you have more than 50 published virtual printers, you cannot print from a USB flash drive to a virtual
printer.
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Print files automatically from a USB flash drive

You can print files automatically from a USB flash drive only if automatic printing is turned on in Configure.

1

Ensure the USB port and automatic printing are enabled, as described in Configuration and Setup or Command
WorkStation Help.

Create folders at the top (root) level of the USB flash drive named print, hold, direct, and the name of any virtual
printer that has been configured and published on the FS2100C Server.

Save the files (EPS, PCL, PDF, PS, or TIFF) from either the Mac or Windows computer to the USB flash drive,
placing the files in the folders that correspond to the action that you want to take.

You can print Microsoft Office files (Word, Excel, Publisher, and PowerPoint) from a USB flash drive if Enable
Native Document conversion using PrintMe is selected in Configure > RIP > Native Documents.

Connect the USB flash drive to the USB port on the FS2100C Server.

The files are automatically printed or held according to the folder they are in.

For the location of the USB port, see Configuration and Setup.

After the files have arrived in the related queue, remove the USB flash drive from the FS2100C Server.

Make sure that the USB flash drive is properly stopped before you disconnect it from the FS2100C
Server.

Print using USB Media Server

You can select files to print from a USB flash drive connected to the FS2100C Server.

When USB Media Autoprint is disabled in Configure, you must manually select the files that you want to print from
the USB flash drive and specify where you want to send them

1

2
3
4
5

Ensure the USB port is enabled, as described in Configuration and Setup or Command WorkStation Help.
Insert the USB flash drive into a USB port on the FS2100C Server.

Make sure the FS2100C Server is not printing or processing files.

Press the Home button on the printer control panel.

Press the Fiery logo.

The FS2100C Server screen appears.

You can press the Home button at any time to return to the main screen.

Press the button at the bottom of the window (the button is named for the current tab).

Press the USB Media Server tab.
The files and folders on the USB flash drive are displayed on the tab.
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8 Navigate to the file that you want to print and select it.
To open a folder, select the folder from the list.

To return to a higher-level folder, press Upper Folder.
9 To navigate through the list of files and folders, you can press the First icon, Prev icon, Next icon, or Last icon.
10 Print one file or all files in the directory.

¢ To print one file, press the Print icon next to a file.

e To print all files in the directory, press Print All located in the upper-right corner of the USB tab window.
11 Specify print options for the file.

¢ Queue (Hold, Print, Direct, or any published virtual printer set up for the FS2100C Server)

o Copies (default is 1)

¢ Duplex (Default, Off, Top-top, Top-bottom)

¢ Paper size (Default, list of available page sizes)
12 Press Print to send the file to the FS2100C Server for printing or Cancel to cancel the print request.
13 Press Services Home button on the printer control panel.

14 Remove the USB flash drive from the FS2100C Server.

Print and retrieve a secure print job

The Secure Print feature offers a level of security for confidential or sensitive print jobs, which print only when you
are present at the printer control panel.

To use this feature, you first enter an arbitrary password into the Secure print field in the printer driver when you
send your job to the FS2100C Server. Then, to print your job, you re-enter the password at the printer control panel.

Send a secure print job

1 Inyour application, do one of the following:

¢ On Windows computers: Select File > Print, select the FS2100C Server as your printer, click Properties, and
then click the Job Info icon.

¢ On Mac computers: Select File > Print, select the FS2100C Server as your printer, select Fiery Features from the
drop-down list, click Full Properties in the Quick Access pane, and then click the Job Info icon in the Printing
Preferences dialog box.
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Type an arbitrary password in the Secure print field.

Note: The password requires at least 1 character and can be up to 31 characters long. It is limited to
alphanumeric characters and "-","_", and "." symbols only.

For more information about typing the password, see Job Info options on page 52.
Make any other required changes to Job Properties.
Click OK to close the FS2100C Server Properties dialog box.

Click OK or Print to close the Print dialog box and send your job to the FS2100C Server.

The job is sent to the printer.

Retrieve a secure print job from the printer

Make sure the FS2100C Server is not printing or processing files.
Press the Home button on the printer control panel.

Press the Fiery logo.
The FS2100C Server screen appears.

You can press the Home button at any time to return to the main screen.
Press the button at the bottom of the window (the button is named for the current tab).

Press the Secure Jobs tab.

On the Secure Print screen, type the same password that you typed in the Secure print field of the printer driver,

and then press Show Files.
The print jobs that match the password are displayed in the login window.
Select your print job and choose Print or Delete.

After 45 seconds of inactivity, the Secure Password screen returns to the main screen.

FTP printing

You can send jobs to the FS2100C Server using FTP printing if the FS2100C Server is set up as an FTP server with
FTP Services configured on it.

For more information about configuring FTP Services, see Command WorkStation Help.

You can use any FTP client application. Before you use FTP printing, the FTP client application requires the
following information (see your administrator):

IP address or DNS name for the FS2100C Server

Directory or path to send the job to, such as the Print queue, Hold queue, or published virtual printers (if
supported)

44
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Note: You cannot print to the Direct connection with FTP printing.
e User name and password (if required)

You can send the following files to the FS2100C Server:

PostScript (PS)

Printer Control Language (PCL)

Tagged Image File Format (TIFF)

Portable Document Format (PDF)

Note: Encapsulated PostScript (EPS) files are not supported for FTP printing.

Print files to the FS2100C Server with the FTP protocol

You can use the FTP protocol to print files to the FS2100C Server.
1 Connect to the FS2100C Server with your FTP client application.

Folders corresponding to the Print queue, Hold queue, and any published virtual printers are displayed.
2 Navigate to the folder representing the print connection or published virtual printer.

3 Upload your job to the appropriate folder.
After the job is printed, it is deleted from the FS2100C Server.

Adobe PDF Print Engine

The Adobe PDF Print Engine is an additional interpreter that allows native PDF processing and rendering without
requiring the FS2100C Server to convert the job from PDF to PostScript.

No special printer driver is required for printing PDF Print Engine jobs, but the administrator must turn on related
settings in Setup. If PDF Print Engine is not turned on, PDF files are processed with the PostScript interpreter of the
FS2100C Server. All PostScript files continue to be processed with the PostScript interpreter.

The PDF Print Engine option is not available from the printer driver, but is included in Job Properties in Command
WorkStation. After the administrator turns on PDF Print Engine as the default in Configure, you can turn on or turn
off the PDF Print Engine option in Job Properties on a per-job basis.

To turn on the PDF Print Engine workflow in the FS2100C Server, see Configuration and Setup.
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Print with the Adobe PDF Print Engine workflow

You can use the PDF Print Engine workflow to print files to the FS2100C Server.

You can print with the PDF Print Engine workflow using one of the following methods:

¢ Command WorkStation
Import a job, or drag a job from your computer to the Job Center.
For more information, see Fiery Command WorkStation Help.

o Fiery Hot Folders
Configure a hot folder for PDF Print Engine.

For more information, see Fiery Hot Folders Help.

Use Adobe PDF Print Engine workflow in Command WorkStation

1 Double-click a PDF job in the Held or Printed queue, or select the job and do one of the following:

¢ Right-click to select Properties.
¢ Select Job Center > Properties.

o Select Properties from the Actions menu.
2 Select the Adobe PDF Print Engine Preferred check box.

3 Specify the print option settings, and then click Print.

Print multiple files with Adobe PDF Print Engine workflow

You can print multiple files at the same time with the PDF Print Engine workflow.

46

If you open the Job Properties window for files of different file types, the Adobe PDF Print Engine Preferred option is

displayed only if one of the selected files is a PDF. The print option name is shown as Adobe PDF Print Engine
Preferred (Applies only to PDF Jobs) and the check box indicates at least one of the PDF jobs selected has been
processed through the PDF Print Engine workflow.

For a multiple file selection containing non-PDF files, the Adobe PDF Print Engine Preferred option is not shown.

If a PDF file contains mixed page sizes when processed using PDF Print Engine, the Paper size option reflects the size
of the first page in the PDF. If you override the Paper size option in the Job Properties window, all of the pages in the

PDF become the selected size.
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Access the properties of multiple jobs

You can specify print options for multiple jobs selected at one time.

1 Use shift-click to select multiple, sequential jobs, or ctrl-click to select multiple, non-sequential jobs, and then
click Properties.

Menus for each available print option are displayed in the Job Properties window.
2 After the multiple jobs have opened, specifying a value in the Job Properties window applies it to all jobs.

The Summary tab allows a side-by-side comparison of the specified print options for multiple jobs.

Direct Mobile Printing

Direct Mobile Printing allows direct printing to the FS2100C Server from mobile devices, such as iPad, iPhone, and
iPod touch.

The FS2100C Server must have certain networking options turned on in Setup. After Setup is complete, the FS2100C
Server appears in the list of available printers on the mobile device.

In addition, observe the following configuration requirements:

e Make sure that the FS2100C Server is connected to a wireless access point on the network.

e Make sure that supported mobile devices are connected to the same wireless network as the FS2100C Server.
The Printer Default Paper Size is used for all Direct Mobile Printing jobs.

For information about configuring the settings in Setup on the FS2100C Server, see Configuration and Setup.

For a list of supported mobile devices, see Configuration and Setup.

Print from a mobile device

You can print files from your mobile device to the FS2100C Server.
1 On the mobile device, select the job, and then open the Print window.

For more information, see the documentation that accompanies your device.
2 Select FS2100C Server in the list of available printers.

3 Specify print settings, and click Print.

Print with Fiery JDF

Fiery JDF allows submission of JDF jobs to a FS2100C Server from applications that can create JDF tickets.
Use Configure to specify JDF settings and to view the Fiery JDF version, the JDF Device ID, and the JMF URL. For
more information, see Fiery Command WorkStation Help.

1 From Configure, choose Job Submission > JDF Settings.
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Select Enable JDF.

If a virtual printer is configured for the FS2100C Server, select one from the Use Job settings from virtual printer
option.

Note: Specify this option only if it applies to your specific workflow.

Specify a default print queue from Job action.

Select Override JDF job with the above settings, if you want to override the settings specified in the JDF ticket.
Specify if you want the JDF jobs to be closed automatically or manually after printing.

Specify the items required for closing a JDF job. The criteria you select here must be fulfilled before the job can
close automatically or manually.

Specify the network paths where the FS2100C Server searches for common resources.

Click Save.

Web Services for Devices printing

Web Services for Devices (WSD) allows printing from Windows computers for supported operating systems, and
Windows 8.1 or later based tablets.

The WSD option on the FS2100C Server must be turned on in Setup. After Setup is complete, you can install the
WSD printer driver for the FS2100C Server.

For information about configuring the settings in Setup on the FS2100C Server, see Configure Help.

Install the WSD printer driver

You can install the WSD printer driver on Windows computers and tablets for supported operating systems.

1
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Download the printer driver with WebTools.

For instructions on downloading the printer driver with WebTools, see Download printer drivers with WebTools
on page 11.

In the Fiery Driver Installer dialog box, select the printer driver language and click Next.
Click Next in the Welcome to the InstallShield Wizard for Fiery Driver Installer dialog box.
Read the license agreement, click | accept the terms of the license agreement and click Next.
Select Add a network, wireless or Bluetooth printer.

Select the printer from the list of available printers and proceed to step 10.

Note: The WSD printer shows the FS2100C Server with the printer in parentheses for the name of the printer.
If the printer is not listed, proceed to step 7.
Click The printer that | want isn't listed.

Click Add a printer using TCP/IP address or host name and click Next.
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9 Select Web Services Device for Device type, type the IP address of the FS2100C Server, and click Next.
Connection to the printer is initiated and the printer driver is installed.
10 Click Next and follow the on-screen instructions.

Do not share the printer. Indicate whether you want to make this printer as the default printer and do not print a
Test Page at this time.
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Print Options

Print Options describes the FS2100C Server printer driver, available print options, and where to set print options to
print your jobs successfully.

About the FS2100C Server printer driver

Windows and Mac computers communicate with the FS2100C Server by means of a printer driver and a PostScript
Printer Description (PPD) file. A PPD file contains information about the features and capabilities of a particular
printer (for example, what paper sizes and media types are supported) and the FS2100C Server.

A printer driver manages printing communication between your application and the printer. It interprets the
instructions generated by the application, merges those instructions with printer-specific options you set, and then
translates all information into Adobe PostScript, a language the printer understands. In other words, the printer
driver writes a PostScript file based on your original file and the options you set from the Print dialog box.

The FS2100C Server receives files from computers on the network, processes the files, and then sends them to the
printer.

For information about the specific print options for the FS2100C Server, see Print options and default settings on
page 51.

Set print options for the job

Print options give you access to the special features of your printer and the FS2100C Server.

You can specify print options in these areas:

e Setup

Some settings are specified during the initial FS2100C Server configuration by the administrator. For
information about the current default server settings, contact the administrator or operator.

e Applications
With the printer drivers provided, you can specify job settings when you print a job.
e Color Setup

You can set the default CMYK source, CMYK rendering intent, Separate RGB/Lab to CMYK source, RGB source,
RGB rendering intent, Spot color matching, Grayscale source, Grayscale rendering intent, Black text and graphics,
Black overprint (for pure black) and Output profile settings.

For more information, see Color Printing.
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o Fiery Hot Folders

You can assign a group of print options to a Hot Folder. When you specify print options for a Hot Folder, the
print options are assigned to all jobs sent through that Hot Folder. These print options override any default
options.

For more information, see Fiery Hot Folders Help.
o Fiery JobExpert

You can automatically apply suggested job settings to your jobs using Fiery JobExpert. These print options
override any default options.

For more information, see Fiery JobExpert Help.
e Opverrides in the Job Properties window of Command WorkStation
To change job settings from Command WorkStation, double-click a job to display the Job Properties window.

For more information, see Fiery Command WorkStation Help.

Print option override hierarchy

Print option settings that were specified in the printer driver can be overridden either in the Held, Printed or
Archived queue of Command WorkStation.

Note: You can use inline editing in the Job Summary pane as another way to override job properties.

The override hierarchy is as follows:

o Settings from the user’s printer driver override the FS2100C Server Setup settings.
o Settings assigned to Fiery Hot Folders override the user’s printer driver settings.

o Settings made from the job management tools (Job Properties window of Command WorkStation) override the
user’s printer driver settings.

o Settings applied with Fiery JobExpert override the user’s printer driver and preset settings.

Print options and default settings

You can use the printer driver interface to configure a particular print option to print a job. If you choose not to
configure the print option, the FS2100C Server prints the job with the default setting.

For the default settings of the FS2100C Server, as set in the Default settings window (Server > Set Defaults in
Command WorkStation), choosing Unlock All results in the FS2100C Server printing the job with the current server
defaults or previously saved settings.

For options that cannot be configured in Setup, the FS2100C Server prints the job with a preconfigured Factory
Default setting. When you select the printer driver for North America, the default Document size is Letter or for
International, the default Document size is A4.

To determine the current Setup defaults, print the Configuration page from Command WorkStation. (See Fiery
Command WorkStation Help.)

Note: A job uses the FS2100C Server default settings (unless otherwise specified) at the time it is processed for
printing, not at the time it is sent to the FS2100C Server Hold queue.

The print options are organized according to the printer driver icons (tabs).
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Job Info options

The Job Info tab shows all information about the job, including user information that may be required for user
authentication and job handling. It also contains settings for selecting the number of print copies.

Accounting: Enable job tracking

The Enable job tracking print option, when selected, turns on job tracking.

To display the job notes and instructions at print time for the job, select Allow entry of account information.
To use the last job account information for the print job, select Show last entered account information.

To save the last entered job account information in the job notes, select Use last entered account information.

This option is not available from the Job Properties window of Command WorkStation.

Copies
The maximum number of copies is 9999.
The maximum number of jobs in the Printing queue and Archived queue is 2000.

Note: In the Mac printer driver, the Copies field in the Job Info window of Fiery Features is read-only. To change the
number of copies, select Copies & Pages from the Mac printer driver main window (instead of Fiery Features).

Destination

The Destination print option allows you to specify the location to output the print job.

Destination: Schedule printing

The Schedule printing print option, when selected, performs advance print scheduling based on date and time for
the print job.

The job is always printed at specified date and time regardless of the Print queue action setting selected, such as
Print, Print and hold, Process and hold, Hold, or Print and delete.

The job is printed based on the date and time set on the FS2100C Server, not the client computer.

If multiple jobs are selected and defined with the same date and time setting, job order is based on the alphabetical
order of the file names.

Note: This option is invalid if your job is sent to the Direct connection.

Job notes: Notes 1/Notes 2

The Notes print option allows you to specify information about the job.

This field accepts alphanumeric and special characters but does have a maximum limit of 31 characters.

Note: If you enter < or = as the first character, the characters may not be printed in the Job Log, or the application in
use may shut down.
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Job notes: Instructions

The Instructions print option allows you to specify instructions for the operator about the job.

This field accepts alphanumeric and special characters but does have a maximum limit of 127 characters.

Job notes: Print queue action

Select the job action associated with a published queue.
Select Print to send the file directly to printing.

Select Print and hold to save the raster file after printing.
Select Process and hold to process, but not print a job.

Select Hold to spool the job until the operator takes further action. Held jobs can exist in a preprocessed or
processed state.

Select Print and delete to queue a job to be processed, printed, and then deleted. This action ensures that the printed
job is not saved to the Printed list.

Note: This option is invalid if your job is sent to the Direct connection.

Job notes: Secure print

The Secure print print option should be used to print sensitive or confidential documents.

Specify an arbitrary password and re-enter it when you are present at the printer. This field accepts alphanumeric
characters and has a maximum limit of 31 characters.

Print Range

The Print Range print option allows you to specify the page range or odd/even pages to print.

For variable data printing jobs, a range of Records is selected for printing. For imposed variable data printing jobs, a
range of Records and Sheets is printed.

For imposed jobs, a range of Sheets is printed.

Note: If you print a page range within a duplex job and the specified range begins on an even-numbered page, the
page range that is actually printed begins on the page before the specified range. The system automatically changes
the page range to preserve the duplex job pagination.

This option is only accessible from the Job Properties window in Command WorkStation.
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Reporting: Control Bar

The Control Bar feature allows you to add a static color bar and dynamic job information to each printed page at a
user-defined location.

The available settings are:

o Off does not print a control bar for the job.

¢ Fiery is the default control bar that provides a color bar and dynamic job information for the job.

If you require your own control bar, you can create one by defining custom values in Control Bar under Color Setup
in Device Center of Command WorkStation. For more information about a custom control bar, see Fiery Command
WorkStation Help.

This option is available as part of Fiery Graphic Arts Pro Package. For more information, see Fiery Graphic Arts Pro
Package.

Printer’s default reflects the setting specified in Color Setup in Command WorkStation.

Reporting: Postflight

The Postflight print option is a diagnostic tool that allows you to analyze how data is processed by the FS2100C
Server. You can choose to print an analytical report for a job.

This option is available as part of the Fiery Graphic Arts Pro Package. For more information, see Fiery Graphic Arts
Pro Package.

User authentication: I'm a Guest

The I'm a Guest print option, when selected, allows guest printing.
Guest printing must be turned on at the FS2100C Server.

In Command WorkStation, the management of jobs is determined by how you log on to the FS2100C Server.

User authentication: Password

If user authentication is configured on the FS2100C Server, specify your user Password to print a job. Type your local
password or domain password for user authentication.

User authentication: User name

If user authentication is configured on the FS2100C Server, specify your User name to print a job. Type your user
name or domain\user name for user authentication.

User authentication: Use Windows Login

If you are logged on to your Windows computer, select Use Windows Login for user authentication. This option
appears when you log on to your domain on your Windows computer.

For more information, see Configuration and Setup.
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Media options

The Media tab shows attributes and sources of paper to print and insert.

Document size

The Document size print option is the page size defined in your application’s Print setup (or Page setup) dialog box.

When printing one document page per sheet of paper, document size is usually the same as output paper size.
However, document size may differ when printing booklets or imposing multiple document pages on a single sheet.

Document size may also differ from output paper size when you use the Scale or Scale to fit options, in which case
the document page size is scaled at a given percent to fit a certain paper size.

To assign document size, do one of the following:

o Select the size from the available list.
SEF stands for Short Edge Feed; LEF stands for Long Edge Feed.

¢ Click Custom to select a non-standard paper size.

Note: The Document size option is grayed out and cannot be changed. You can specify the document size with the
Paper size option from the Mac printer driver.

Media type

Specify the Media type for your print job.

For information about media types and paper specifications, see the documentation that accompanies the printer.

Mixed media

The Mixed media print option allows you to specify different media types, paper sizes, and paper source to use
within a print job.

For more information, see printer driver help.

For information about accessing and using Mixed media, see Command WorkStation Help. Features specific to the
FS2100C Server are described in Utilities.

Mixed orientation paper size

The Mixed orientation paper size print option, when selected, specifies that the job contains mixed orientation
mixed paper sizes.

Paper Catalog

The Paper Catalog print option provides access to the Paper Catalog utility, which retrieves all paper information
from the printer.

For information about Paper Catalog, see Utilities and Fiery Command WorkStation Help.
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Note: This option is invalid if your job is sent to the Direct connection.

Access to Paper Catalog requires Two-Way Communication. For information about selecting Two-Way
Communication, see printer driver help.

Paper size

The Paper size print option defines the size of the sheet of paper on which your job prints. It is the size of the
physical sheet of paper in the printer tray.

To assign paper size, do one of the following:

o Select the size from the available list.
SEF stands for Short Edge Feed; LEF stands for Long Edge Feed.
¢ Click Custom to select a non-standard paper size.

e Select Same as document size to print one document page per sheet of paper.

Paper source

Specify the paper tray that contains the paper to use for your print job.

Auto tray select automatically uses the tray containing the paper size specified for the job. This setting also allows the
printer to automatically switch between trays, if the current tray becomes empty, while continuing to print.

Note: Some trays are options and must first be installed. (See printer driver help.)

For information about setting your choice of media in one of the trays, see the documentation that accompanies
your printer.

Tray alignment

The Tray alignment print option should be selected when you need to adjust the image on the page to achieve
alignment on both sides of a page when printing duplex.

For more information, see Command WorkStation Help.

Use set page device media mapping

The Set Page Device (SPD) feature commands are instructions that specify certain attributes of a print job.

The commands are delivered within the following file formats:

e DPostScript
e VPS

The Set Page Device option must be turned on in Configure. (See Fiery Command WorkStation Help.)
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Select the Use set page device media mapping check box in Job Properties to allow the FS2100C Server to recognize
and apply certain attributes of a print job on a job-level basis, including:

o DPaper attributes (for example, media type)
o Finishing attributes (for example, stapling or folding)
e Generic attributes (for example, simplex or duplex, number of copies)

This option is accessible only from Command WorkStation Job Properties.

Layout options

The Layout tab defines the imposition of the print job and the booklet process on the media/sheet, except for
positioning that compensates for finishing options, for example, Tray alignment.

The printer driver has the following layout modes:

e Normal is used for printing standard documents, from 1 to 16 document pages per sheet. (See Normal layout
options on page 57.)

¢ Gangup is used for speed printing imposition modes. (See Gangup layout options on page 59.)

o Booklet is used for printing documents in booklet layout. (See Booklet options in the printer driver and Job
Properties on page 60.)

e Impose is used for imposition layouts for custom printing, binding, and trimming. (See Impose layout options on
page 68.)

Note: The Impose option is only accessible from Command WorkStation Job Properties.

Normal layout options

Normal layout options are used for printing standard documents, from 1 to 16 document pages per sheet.

Normal

Select Normal to specify options for printing standard documents.

Duplex

The Duplex print option allows you to print a job with duplex (double-sided) pages.
Select Off for single-sided printing.

Specify Top-top or Top-bottom for duplex (double-sided) printing by specifying the orientation of printed
images.

For more information, see Print Duplex (double-sided) pages on page 103.
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Mirror

The Mirror print option, when selected, prints the mirror image of the job.

This option is not available from the Mac printer driver and the Job Properties window of Command
WorkStation.

Orientation override

The Orientation override print option is used with jobs that do not have an orientation or that have incorrect
orientation.

It specifies the orientation to use for finishing settings (for example, stapling) that interact with orientation and
for flowing pages on N-up layouts. In some cases, the orientation of a job may be correct in print, but incorrect
in preview.

This option is accessible only from the Job Properties window of Command WorkStation.

Orientation

The Orientation print option allows you to specify Portrait or Landscape page orientation for the document.

This option is not available from the Mac printer driver and the Job Properties window of Command
WorkStation.

N-up option: Page Order

Specify the layout direction when the Pages per Sheet option is set to 2-up or greater.

N-up option: Pages per Sheet

Specify the number of document pages per sheet of paper for your print job.

This option cannot be used with the Create master or Use master options.

Note: This option is invalid if your job is sent to the Direct connection.

N-up option: Print border

Select to turn on Print border to print borders around each page in your print job.

Scale

Specify an increase or decrease in the scale of your print job. When using the manual Scale option, you cannot
specify Scale to fit.

The operator can specify a scaling override in Command WorkStation, but the override is applied to any scaling
value already set in the active job. For example, if a user sends a job with a scaling value of 50% and the operator
specifies a Scale override of 300%, the job is printed at 150% of the original document size, that is, 50% of 300%.
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Scale to fit

The Scale to fit option allows you to specify whether to scale your job to fit to the paper size or the imageable
area. When using the Scale to fit option, you cannot use the manual Scale option.

Choose one of the following:

¢ Scale to fit (Sheet size) will automatically scale the image to fit the paper size, which is different than the
document size, that is selected from the Paper size menu in the Media tab.

o Scale to fit (Imageable area) will automatically increase or reduce the size of the image to fit the imageable
area of the paper size you select from the Paper size menu in the Media tab. The document size is scaled to
the printable imageable area of the paper.

For more information, see Document size and paper size on page 96.

Gangup layout options
Gangup layout options are used for speed printing imposition modes.

Note: The Gang-up feature is not valid if your job is sent to the Direct connection.

Gangup

Select Gangup to specify options for speed printing imposition modes.

Gang-up type

Gangup booklet has two types used for speed printing imposition: Step & repeat and Cut & stack.

Select Step & repeat to speed print a job by printing two document pages on each sheet. When the printed
sheets are cut in half, the result is two complete sets of the same document.

Select Cut & stack to speed print a job by printing two document pages side by side. When the printed sheets are
cut in half and stacked together, the result is one complete set of the document (in faster printing time).

For more information, see Gang-up printing on page 99.

Page Alignment: Duplex

The Page Alignment: Duplex print option allows you to select the duplex (double-sided) setting to specify the
orientation of printed images for gang-up printing.

Select Off for single-sided printing.
Specify Top-top for duplex (double-sided) printing by specifying the orientation of printed images.
Specify Top-bottom for duplex (double-sided) printing by specifying the orientation of printed images.

For more information, see Print Duplex (double-sided) pages on page 103.
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Page Alignment: Increase gutter by

Increase gutter by controls the amount of space between adjacent pages on a sheet to adjust for trimming or
other finishing options.

You can specify the gutter value from -1.969 to 1.969 inch in 0.001 inch increments (-50.0 to 50.0 mm in 0.1 mm
increments).

Specify a positive value to increase the amount of blank space between adjacent pages.
Specify a negative value to decrease the amount of blank space between adjacent pages.

For more information, see Booklet Maker Help.

Paper Size

The Paper Size print option defines the size of the sheet of paper on which your job prints. It is the size of the
physical sheet of paper.

To assign paper size, select one of the following:
o Select the size from the available list.
SEF stands for Short Edge Feed; LEF stands for Long Edge Feed.

¢ Choose Select From Paper Catalog to access a dynamic database on the FS2100C Server that stores the
media attributes of any paper available for printing.

o Select Custom Paper Size to select a non-standard paper size.

o Select Same as document size to print on a sheet of paper the same size as the original document page size.

For information about Document size and Paper size, see Document size and paper size on page 96.

For information about accessing Paper Catalog, see Utilities. For information about using Paper Catalog, see
Fiery Command WorkStation Help.

Paper Size: Shrink to fit

The Shrink to fit print option, when selected, automatically scales down or reduces the document page size to fit
the imageable area of the selected paper size specified from the Paper Size menu. Shrink to fit does not scale up
or enlarge.

Select one of the following settings:
o Off - prints the page contents at 100%.
¢ Sheetsize - shrinks the page contents to fit the sheet size.

¢ Imageable area - shrinks the page contents to fit the imageable area.

Booklet options in the printer driver and Job Properties

Booklet layout options are used for printing documents in booklet layout.

The Booklet Maker print options are accessible from the printer driver. For the Booklet Maker print options
accessible from Command WorkStation Job Properties, see Booklet Maker in the printer driver and Command
WorkStation Job Properties on page 91.
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Note: The Booklet Maker feature is not valid if your job is sent to the Direct connection.

You can use the Booklet Maker Wizard to specify booklet options by clicking Launch Wizard.

Booklet

Select Booklet to specify options for printing documents in Booklet layout.

Click Launch Wizard to specify how to arrange the pages of the job in special layouts for folding or cutting after

printing.

Booklet Type

Booklet Type is a combination of binding method, which determines how the signatures of the booklet are
folded and imposed, and binding edge, which determines the location of the spine of the booklet.

For information about 1-up Perfect binding booklets, see 1-up Perfect Binding Booklet options on page 63.

For information about Booklet printing, see Booklet Maker Help.

Cover: Back cover

61

When Front & Back Separately is selected for the Content input print option, use the Back cover option to define

how the content of the back cover is printed.

Select Print on outside to print only on the outside of the back cover (the inside of the back cover is blank).
Select Print on inside to print only on the inside of the back cover (the outside of the back cover is blank).
Select Print on both sides to print on both the inside and outside of the back cover.

Select Do not print if you do not want any content printed on the back cover.

When you add a cover, blank pages may be inserted, depending on the allocation of pages to signatures in the
job. For more information, see Booklet Maker Help.

Cover: Content input

The Content input print option provides cover type settings for your Saddle booklet.

Select Front & Back Separately to include cover content (individual pages in your document) as part of your
booklet print job.

Select Pre-printed (use insert) to insert a pre-printed cover that is added to the body pages from an inserter tray.

For more information, see Booklet Maker Help.

Cover: Define Cover (for Saddle books only)

Click Define Cover to specify the cover options.
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Cover: Front cover

When Front & Back Separately is selected, use the Front cover option to define how the content of the front
cover is printed.

Select Print on outside to print only on the outside of the front cover (the inside of the front cover is blank).
Select Print on inside to print only on the inside of the front cover (the outside of the front cover is blank).
Select Print on both sides to print on both the inside and outside of the front cover.

Select Do not print if you do not want any content printed on the front cover.

When you add a cover, blank pages may be inserted, depending on the allocation of pages to signatures. For
more information, see Booklet Maker Help.

Page Alignment: Align pages
Align pages positions page content in relation to the center of one-half the paper size or the spine, the center of
the sheet where the fold occurs.
At the center positions page content in the center of one-half the specified paper size.
At the spine aligns page content with the spine or center fold of your booklet.

For more information, see Booklet Maker Help.

Page Alignment: Compensate creep

Compensate creep adjusts the position of the page content to counteract the shift that occurs when sheets are
folded and combined to create Saddle and Nested Saddle booklets.

Select Plain when printing Saddle or Nested Saddle booklets with a large number of pages.
Select Thick when printing Saddle or Nested Saddle booklets on heavyweight paper.

For information about printing booklets, see Booklet Maker Help.

Page Alignment: Increase gutter by

Increase gutter by controls the amount of space between adjacent pages on a sheet to adjust for trimming or
other finishing options.

You can specify the gutter value from -1.969 to 1.969 inch in 0.001 inch increments (-50.0 to 50.0 mm in 0.1 mm
increments).

Specify a positive value to increase the amount of blank space between adjacent pages.
Specify a negative value to decrease the amount of blank space between adjacent pages.

For more information, see Booklet Maker Help.
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Paper Size: Paper Size for 2-up

The Paper Size for 2-up print option defines the size of the sheet of paper (unfolded) on which a booklet is
printed. It is the size of the physical sheet of paper.

To assign a paper size for a booklet, select one of the following:

Select the size from the available list.
(SEF stands for Short Edge Feed; LEF stands for Long Edge Feed.)

Choose Select From Paper Catalog to access a dynamic database on the FS2100C Server that stores the
media attributes of any paper available for printing.

Select Custom Paper Size to select a non-standard paper size.

Select Same as document size to print on a sheet of paper the same size as the original document page size.

For information about Document size and Paper size, see Document size and paper size on page 96.

For information about accessing Paper Catalog, see Utilities. For information about using Paper Catalog, see
Fiery Command WorkStation Help.

For more information about printing booklets, see Booklet Maker Help.

Paper Size: Shrink to fit

The Shrink to fit print option, when selected, automatically scales down or reduces the document page size to fit
the imageable area of the selected paper size specified from the Paper Size menu. Shrink to fit does not scale up
or enlarge.

Select one of the following settings:

Off - prints the page contents at 100%.
Sheet size - shrinks the page contents to fit the sheet size.

Imageable area - shrinks the page contents to fit the imageable area.

Subset Size: Number of sheets in a subset (saddle) (for Nested Saddle books only)

When Nested Saddle is selected for booklet type, use the Number of sheets in a subset (saddle) print option to
specify the number of sheets in each subset.

1-up Perfect Binding Booklet options

The 1-up Perfect Binding Booklet layout options are used for printing documents in booklet layout where single
body pages are stacked together, so that the edges may be trimmed (if desired) and glued, and then wrapped by a
cover sheet.
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1-up Perfect binding

To print a 1-up Perfect binding booklet, your printer must be equipped with an advanced finisher that supports
Perfect binding.

Select a binding method for the 1-up Perfect booklet:
e Select Left Binding for a book that reads from left to right, with the spine (binding edge) at left.
e Select Right Binding for a book that reads from right to left, with the spine (binding edge) at right.

o Select Top Binding for a book that reads from top to bottom, with the spine (binding edge) at the top.

For more information, see Booklet Maker Help.

Body Paper Size

The Body Paper Size print option allows you to specify the paper size for the body pages of the booklet.

To select a Body Paper Size for your booklet, do one of the following:

o Select from the list of available sizes.
SEF stands for Short Edge Feed; LEF stands for Long Edge Feed.

¢ Choose Select From Paper Catalog to access a dynamic database that stores the media attributes of any paper
available for printing from the FS2100C Server.

e Select Custom Paper Size to create a non-standard paper size, using the Custom Paper Size width (feed edge)
and height dimensions.

e Select Same as document size to print one document page per sheet of paper.

o Select Edit to define media attributes for the body paper size.

For more information, see Booklet Maker Help.
For information about accessing Paper Catalog, see Utilities.
For information about using Paper Catalog, see Fiery Command WorkStation Help.

For information about document size and paper size, see Document size and paper size on page 96.

Body Position: Booklet scaling

Specify how to scale the document pages in the 1-up Perfect booklet.

Select Shrink to body size to automatically scale down the document page to fit the paper size specified from the
Body Paper Size menu.

Specify None when booklet scaling is not necessary.

Body Position: Align pages

The Align pages print option positions page content in relation to the center of one-half the paper size or the
spine, the center of the sheet where the fold occurs.

At the spine aligns page content with the spine or center fold of your booklet.
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At the center positions page content in the center of one-half the specified paper size.

You can fine-tune the alignment of the page content vertically (parallel to the spine) or horizontally
(perpendicular to the spine) by specifying values.

For more information, see Booklet Maker Help.

Body Position: Custom adjustment horizontally or vertically

You can fine-tune the alignment of the body page content horizontally (perpendicular to the spine) or vertically
(parallel to the spine).

You can specify the adjustment value in 0.001 inch increments (0.1 mm increments).
Specify a positive value to increase the amount of blank space between the body pages and the binding edge.

Specify a negative value to decrease the amount of blank space between the body pages and the binding edge.

Cover Content: Back cover

When Front & Back Separately is selected, use the Back cover option to define how the content of the back cover
is printed.

Do one of the following:

o Select Print on outside to print the cover content only on the outside of the back cover (the inside of the
back cover will be blank). This is the default setting.

o Select Print on inside to print the cover content only on the inside of the back cover (the outside of the back
cover will be blank).

o Select Print on both sides to print on both the inside and outside of the back cover

¢ Select Do not print if you do not want any content printed on the back cover.

When you add a cover, blank pages may be inserted depending on the allocation of pages to signatures.
The back cover content pages must be specified as the second to last and last pages within the source document.
This option is available when the Content input option is Front & Back Separately.

For information about cover options, see Booklet Maker Help.

Cover Content: Content input

Specify the cover type for your booklet.

Select Front & Back Separately to include cover content (individual pages in your document) as part of your
booklet print job. This is the default setting.

Select Pre-Printed to insert a pre-printed cover that will be merged with the body pages of your booklet, which
print separately.

For information about cover options, see Booklet Maker Help.
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Cover Content: Content

The Content print option allow you to decide whether your cover content prints on the outside or both sides of
the cover.

Do one of the following:

o Select Outside of the cover to print the cover content only on the outside of the cover (the inside of the cover
will be blank). This is the default setting.

o Select Both sides of the cover to print content on both the inside and outside of the cover.

This option is available when the Booklet Type print option is 1-up Perfect, and Content input print option is
Front & Back Together.

Cover Content: Front cover

The Front cover options allow you to quickly decide whether your front cover prints duplex, single-sided, or
both sides blank, without needing to add blank pages in your original document.

Do one of the following:

e Select Print on outside to print the cover content only on the outside of the front cover (the inside of the
front cover will be blank). This is the default setting.

¢ Select Print on inside to print the cover content only on the inside of the front cover (the outside of the front
cover will be blank).

¢ Select Print on both sides to print on both the inside and outside of the front cover.

o Select Do not print if you do not want any content printed on the front cover.

When you add a cover, blank pages may be inserted depending on the allocation of pages to signatures.
The front cover content pages must be specified as the first and second pages within the source document.
This option is available when the Content input option is Front & Back Separately.

For information about cover options, see Booklet Maker Help.

Cover Content: Spine content

Specify how to print content on the spine of your booklet.
Select None if you wish to not print on the spine of the booklet. This is the default setting.

Select Document page to print content on the spine of the booklet. Printing of the spine is achieved by using the
last document page as the spine.

For top binding, the spine content is rotated 180 degrees to ensure the spine content is in the correct orientation
for reading.

This option is available when the Content input option is Front & Back Separately.
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Cover Content: Spine width

Specify the value for the spine width of the booklet. The spine width value is used to determine the trim amount,
and cover paper size.

When the Content input option is Front & Back Separately, the spine width value is used to determine the
distance between the front and back cover content.

When the Content input option is Front & Back Together or Pre-printed, the cover content has already been
printed or included in the document source, therefore the spine width does not alter the cover layout.

Cover Position

Specify the placement of the cover content to be centered vertically and horizontally within the cover sheet.
You can specify the cover position value in 0.001 inch increments (0.1 mm increments).
Specify a positive value to increase the amount of blank space between the cover pages and the spine.

Specify a negative value to decrease the amount of blank space between the cover pages and spine.

Cover Paper Size

The Cover Paper Size print options allows you to specify the cover paper size for the booklet cover.

To select a Cover Paper Size for your booklet, do one of the following:

e Select from the list of available sizes.

o Select Select From Paper Catalog to access a dynamic database that stores the media attributes of any paper
available for printing from the FS2100C Server.

o Select Custom Paper Size to create a non-standard paper size, using the Custom Paper Size width (feed edge)
and height dimensions.

o Select Edit to define media attributes for the cover paper size.

For more information, see Booklet Maker Help.
For information about accessing Paper Catalog, see Utilities.
For information about using Paper Catalog, see Fiery Command WorkStation Help.

For information about document size and paper size, see Document size and paper size on page 96.

Mixed Media
The Mixed Media print option allows you to make selections that affect the pagination and the sheet layout for
the print job.

When Mixed Media is used in Booklet Maker, it will be disabled in the Media tab, but selections made in Mixed
Media in 1-up Perfect binding are displayed in the Media tab and in Compose.

In the Mixed Media area, specify the chapter start pages, define the page ranges and media, and new blank
inserts and media.

Note: The Define Each chapter as a Separate Finishing Set print option is available only in the Mixed Media area
on the Media tab.
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Implicit and explicit blanks are denoted by different thumbnails. Implicit blanks are inserted when the page is
designated as a chapter start in a two-sided (duplex) job. Explicit blanks are those inserted by the user.

The Sheet tab presents the pagination of the job with the order of the sheet as the primary focus. The sheets are
presented in linear order, which corresponds to the actual print order on the printer. The cover is always
presented first, even if the cover may be printed as the last sheet.

The Page tab presents the pagination of the job with the order of the document page as the primary focus. The
pages are presented in linear order, which corresponds to the logical reading order of the source document.

The Mixed Media option for 1-up Perfect binding is only accessible from Command WorkStation Job
Properties.

Unit

Specify the units for the booklet.

Impose layout options

Fiery Impose provides several pre-defined imposition templates used for custom printing, binding, and trimming.
Impose is an option on the FS2100C Server.
The Impose option is only accessible from Command WorkStation Job Properties.

For more information, see Command WorkStation Help.

Impose

Select Impose to specify an imposition layout for a job.

Templates

Specify an imposition layout template for a job.

The available templates are as follows:

e Normal: Default Template and 1-up full bleed

e Booklet: 2-up perfect, 2-up saddle, and 4-up head to head

e Gangup: 3-up trifold brochure, 4-up gate fold, and 4-up z fold

Edit Impose Template

You can edit the imposition template in Fiery Impose.
Click Edit Impose Template to open a template in Fiery Impose for editing.

For information about Impose, see Utilities. For information about using Impose, see Command WorkStation
Help.
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Color options

The Color tab shows color settings and additional features (when turned on).

Color mode

Select the color mode for the current print job.
Specify the color mode for the print job by doing one of the following:
¢ Select CMYK for a color document.

¢ Select CMYK+ to print color output with CMYK colorants plus a fifth colorant, using all colorants as process
colors. The fifth colorant can be Red or Gray. For more information, see Color Printing.

e Select Grayscale for a grayscale or black-and-white document.

¢ Select Use gray ink to apply the fifth colorant gray in grayscale color mode.

Output profile

The Output profile print option specifies the output profile used to process a job. Color data in a print job is
converted to the color space of the printer, which is described by the output profile.

The Use job defined settings setting automatically selects the output profile associated with the color mode and
media type used in a print job rather than a specific output profile. If a job uses media from Paper Catalog, the
output profile specified for the media in Paper Catalog is used.

For more information, see Color Printing.

Calibration

Calibration shows the current calibration used to process the job. If you change the color mode, you must reprocess
the job to apply the new calibration.

Color input options

RGB source

The RGB source print option allows you to specify a source color space definition for printing RGB images,
graphics, and text.

For more information, see Color Printing.

Use RGB embedded profiles

When the Use RGB embedded profiles option is selected, the FS2100C Server ignores the RGB Source option and
uses the RGB profile embedded in the print job as the RGB source profile.

For more information, see Color Printing.
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RGB rendering intent

The RGB rendering intent print option allows you to specify a default CRD (color rendering dictionary) for color
conversion when printing RGB images, graphics, and text.

Do one of the following:

o Select Photographic to print photographs, including scanned and digital camera images. The result is less
saturated than Presentation style.

o Select Presentation to print files with artwork, graphics, and text. The result is similar to Photographic, with
well-rendered in-gamut colors, such as flesh tones, and more saturated colors.

¢ Select Absolute Colorimetric when exact colors are required and visible borders are not distracting. There is
no white point transformation.

o Select Relative Colorimetric when color matching is important, but you also want to print white as paper
white. The white point transformation eliminates borders between blank spaces and white objects.
Note: If you experience tone reproduction problems, set this option to Photographic.

For more information, see Color Printing.

Print RGB gray using black only

The Print RGB gray using black only print option provides settings to print an RGB grayscale job using black
instead of process black.

This option renders the selected object types (Text/Graphics or Text/Graphics/Images) in grayscale using K-only
black. (Graphics refer to vector graphics; Images refer to raster images.)

This option is designed to use black efficiently, by using only black (rather than four-color process black). (See
Color Printing).

CMYK source

The CMYK source print option specifies the simulation profile for the print job.

For more information, see Color Printing.

Use CMYK embedded profiles

When the Use CMYK embedded profiles option is selected, the FS2100C Server ignores the CMYK source option
and uses the CMYK profile embedded in the print job as the CMYK source profile.

For more information, see Color Printing.
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CMYK rendering intent

The CMYK rendering intent print option allows you to specify a default CRD (color rendering dictionary) for
color conversion when printing CMYK images, graphics, and text.

Do one of the following:

o Select Photographic to print photographs, including scanned and digital camera images. The result is less
saturated than Presentation style.

o Select Presentation to print files with artwork, graphics, and text. The result is similar to Photographic, with
well-rendered in-gamut colors, such as flesh tones, and more saturated colors.

¢ Select Absolute Colorimetric when exact colors are required and visible borders are not distracting. There is
no white point transformation.

o Select Relative Colorimetric when color matching is important, but you also want to print white as paper
white. The white point transformation eliminates borders between blank spaces and white objects.

o Select Pure primaries to use one-dimensional transfer curves to adjust density output of individual color
channels.
Note: If you experience tone reproduction problems, set this option to Photographic.

For more information, see Color Printing.

Black point compensation

The Black point compensation option lets you control the output quality of shadow areas for CMYK source
colors.

Use Black point compensation to enhance details in shadows when the CMYK source space is larger than the
gamut of the printer. In proofing applications, when the CMYK source space is smaller than the gamut of the
printer, do not use this option.

Note: For RGB source colors, black point compensation is always applied.

Black point compensation works by scaling the source colors so that the darkest point in the source profile maps
to the darkest point in the output profile.

For more information, see Color Printing.

Print CMYK gray using black only
The Print CMYK gray using black only print option provides settings to print a CMYK grayscale job using black
instead of process black.

This option renders the selected object types (Text/Graphics or Text/Graphics/Images) in grayscale using K-only
black. (Graphics refer to vector graphics; Images refer to raster images.)

This option is designed to use black efficiently, by using only black (rather than four-color process black). (See
Color Printing).
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Grayscale source

The Grayscale source print option defines the source color space for all grayscale objects.

Use Gray embedded profiles

When the Use Gray embedded profiles option is selected, the FS2100C Server ignores the Grayscale source
option and uses the Gray profile embedded in the print job as the Grayscale source profile.

For more information, see Color Printing.

Grayscale rendering intent

The Grayscale rendering intent print option allows you to specify a default CRD (color rendering dictionary) for
color conversion when printing grayscale images, graphics, and text.

Do one of the following:

e Select Photographic to print photographs, including scanned and digital camera images. The result is less
saturated than Presentation style.

o Select Presentation to print files with artwork, graphics, and text. The result is similar to Photographic, with
well-rendered in-gamut colors, such as flesh tones, and more saturated colors.

e Select Absolute Colorimetric when exact colors are required and visible borders are not distracting. There is
no white point transformation.

o Select Relative Colorimetric when color matching is important, but you also want to print white as paper
white. The white point transformation eliminates borders between blank spaces and white objects.
Note: If you experience tone reproduction problems, set this option to Photographic.

For more information, see Color Printing.

Print gray using black only
The Print gray using black only print option provides settings to print a grayscale job using black instead of
process black.

This option renders the selected object types (Text/Graphics or Text/Graphics/Images) in grayscale using K-only
black. (Graphics refer to vector graphics; Images refer to raster images.)

This option is designed to use black efficiently, by using only black (rather than four-color process black). (See
Color Printing).

Spot color matching
Clear the Spot color matching check box to print specified PANTONE colors in your job using the alternate
color space and values for the spot color specified in the source application.

Select to activate the PANTONE Lookup Table. The FS2100C Server uses a built-in table to generate the closest
CMYK matches of spot colors your press can produce. (See Color Printing.)



Printing 73
Print Options

Use spot group

The Use spot group print option allows you to define the spot color library to search first for the spot colors in
the job before searching all other libraries in the FS2100C Server.

Spot color overprint

The Spot color overprint print option defines how two or more spot colors will behave when printed on top of
each other.

Do one of the following:

o Select CMYK to use CMYK addition which is the most common way of calculating the resulting color for an
overprint of two spot colors or of a spot color with process colors.

o Select RGB to use RGB addition to calculate the resulting color for an overprint of two spot colors or of a
spot color with process colors.

o Select Lab to use overprint calculations in the L*a*b* color space and use numerical color values based on the
actual color profiles of the output device.

For more information, see Color Printing.

Color settings options

2-color print mapping

The 2-color print mapping option can be used to replace spot colors and process colors to the generic colors.

Select the 2-color print mapping check box to replace spot colors and process colors with generic colors when
you create a print job.

For more information, see Color Printing.

Auto trapping

Trapping is a technique to print some objects slightly larger or smaller than specified in an application, in order
to prevent white edges around the objects.

These white edges, or “halos,” can be caused by factors such as misregistration, the physical properties of the
inks, and the stiffness of the media. The Auto trapping feature provides you with advanced trapping settings and
gives you full control over their values.

Select this option if the job should automatically reduce white gaps for text and graphics.
Turning on this option may result in graphics or text surrounded with borders.

For more information, see Color Printing.
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Black overprint (for pure black)

The Black overprint (for pure black) print option provides settings for text or text/graphics to overprint in the
job.

Do one of the following:
o Select Off to use conventional processing by knocking out. May produce white halos around objects.
o Select Text to overprint black text.

o Select Text/Graphics to overprint black text and graphics.

For more information, see Color Printing.

Black text and graphics

The Black text and graphics print option specifies how to print black text and graphics in the print job.

Do one of the following:

e Select Normal to print black text and graphics as a four-color black using C, M, Y, and K, and to use normal
PostScript rendering.

e Select Pure Black On to print black text and graphics as a one-color black, using black only.

e Select Rich Black On to print black text and graphics as richer looking black, by layering a small amount of
Cyan underneath the black to make the black even darker.

e Select Convert Rich Black to Pure to print source file defined rich black objects (i.e. Cyan = 50% and Black =
100%) as K-only, using the black colorant only, regardless of CMYK source and CMYK rendering intent
settings.

This option is automatically set to Pure Black On if the Black overprint (for pure black) option is set to Text or
Text/Graphics.

For more information, see Color Printing.

Combine separations
You can print the color separations in the job as a single page or as four individual pages.
When printing separations from supported desktop publishing applications, do one of the following:

o Select the Combine separations check box to combine separations on a single page.

e Clear the check box to view separations as individual black-and-white pages, each representing one color
plate.

For more information, see Color Printing.

Composite overprint

Design applications are typically set to knock out objects.

To overprint, you must first change the settings in the source application. When the Composite overprint option
is turned on, the overprinting attribute specified in the source application takes place, provided the output is in
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composite mode (not printed in separations) and/or is printed with CMYK or Grayscale color mode. (See Color
Printing).

Select this option to overprint objects that are specified in the source PostScript or PDF file.

Optimize RGB transparency

The Optimize RGB transparency print option controls the source color profiles used to manage color conversion
when rendering transparency effects (such as a drop shadow) in a PDF job.

This option is accessible from the Job Properties window of Command WorkStation, Fiery Hot Folders, and
Virtual Printers.

For more information, see Color Printing.

PDF/X output intent

The PDF/X output intent print option, when selected, uses the embedded output intent for PDF/X compliant
print jobs.

To use some PDF/X references, the Use RGB embedded profiles, Optimize RGB transparency, and Separate
RGB/Lab to CMYK source print options must be turned on.

This option is only accessible from the Job Properties window of Command WorkStation. (See Color Printing).

Raster Curve Editor

The Raster Curve Editor print option allows you to adjust individual or all color channel curves. You can create
and save a raster curve preset to adjust the CMYK ouptput of any job.

This option is only accessible from the Job Properties window of Command WorkStation.

Raster curve presets

The Raster curve presets print option applies edits made to the job in Fiery ImageViewer when the job prints.
You can also apply Fiery ImageViewer presets to the job.

Factory-supplied curve edits apply some typical color corrections:
o Lighter highlights

e Midtone boost

e No correction

e Shadow detail

e Reduce C (cyan) cast

e Reduce M (magenta) cast

e ReduceY (yellow) cast
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Separate RGB/Lab to CMYK source

The Separate RGB/Lab to CMYK source print option, when selected for RGB content, simulates the appearance
of CMYK from a different print system.

This option is required with PDF/X workflows and is used to preserve CMYK overprints in transparency effects.

For more information, see Color Printing.

Substitute colors

The Substitute colors print option, when selected, uses the substitute color values defined in Spot-On or Spot
Pro.

Note: Spot Pro is available with the Fiery Graphic Arts Pro Package.

For more information, see Color Printing.

Use embedded black point compensation

The Use embedded black point compensation print option, when selected, uses the embedded output intent for
black point compensation.

Image options

The Image tab shows all image quality settings supported by the connected FS2100C Server and printer.

For information about options specified in Setup, see Configuration and Setup.

Barcode: Barcode processing for graphics

The Barcode processing for graphics print option applies barcode processing on graphic objects.

Barcode: Barcode processing for images

The Barcode processing for images print option applies barcode processing on image objects.

Barcode: Barcode processing for texts

The Barcode processing for texts print option applies barcode processing on text objects.

Barcode: Barcode print density

The Barcode print density print option allows you to increase or decrease the barcode density.

Selecting a negative number will decrease the barcode density and result in the barcode print being lighter. Selecting
a positive number will increase the barcode density and result in the barcode print being darker.
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Brightness

The Brightness print option allows you to specify the image brightness for the print job.

Select 85% lightest for a substantially lighter image, 115% darkest for a substantially darker image, or one of the
settings in between.

Halftone mode

The Halftone mode print option allows you to select a halftone screening method for your print job.

The available settings are:

¢ Standard uses the FS2100C Server halftone screening with a resolution of 300x300 dpi. This option uses true
black (K) with a resolution of 600x600 dpi.

¢ Fine uses the FS2100C Server halftone screening with a resolution of 300x600 dpi. This option uses true black
(K) with a resolution of 600x600 dpi.

e Envelope standard uses the FS2100C Server halftone screening with a resolution of 300x300 dpi for text edge
enhancement.

e Envelope fine uses the FS2100C Server halftone screening with a resolution of 300x600 dpi for text edge
enhancement.

¢ High speed uses the FS2100C Server halftone screening with a resolution of 300x300 dpi for faster processing.

o Draft mode uses the FS2100C Server halftone screening with a resolution of 300x300 dpi for reducing the ink
consumption.

o Standard (Dot screen) uses the FS2100C Server halftone screening with a resolution of 300x300 dpi. The screen is
created using a dot pattern of 100 lpi.

Image enhance: Apply image enhancement

The Apply image enhancement option, when selected, applies photo enhancement to the job.
The supported file formats are PDF, PS, TIFF, and EPS.
This option is not valid for images under 72 dpi. Also, it is not applied to pages with a large number of images.

For more information, see Image enhance on page 101.

Image enhance: Image enhancement range

Specify all pages, specific page(s), or sheets of the document to apply photo finishing enhancement.

Image smoothing

Select the Image smoothing option to minimize grainy output when printing low-resolution (up to 300 dpi) images.

This option is valid for images less than or equal to 150 dpi when the Resolution option is set to 600 dpi.
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Image quality

The Image quality print option allows you to specify the type of image quality for the job.
This option affects the fineness of images in the job; there is a trade-off with processing speed.
Choose one of the following for the print job:

¢ Normal - to print quality images.

e Best - to print the highest quality for text and images.

Max ink volume

The Max ink volume print option allows you to select the maximum amount of ink to print on the selected media.
Select Media defined to use a preset maximum ink volume for the selected media.

Select 1 through 11 to set the maximum ink volume to use for the selected media.

Monochrome printing
The Monochrome printing print option allows you to print grayscale in a different color other than black on paper
types that are not covered by the default paper types.

The Color mode print option must be set to Grayscale, then you can select Cyan or Magenta for Monochrome
printing. You can also select Use gray ink in Color mode to print grayscale using gray ink.

When Monochrome printing is not used, then grayscale is printed in true black (K) and white.

Print density

The Print density print option allows you to increase or decrease the output density for your job.

Selecting a negative number will decrease the value and result in the print being lighter. Selecting a positive number
will increase the value and result in the print being darker.

Finishing options
The Finishing tab shows print options related only to finishing equipment on the printer, and also image shifting to
compensate for finishing options.

These options override settings in FS2100C Server Setup but can be changed from Command WorkStation.

Cover page

The Cover page print option, when selected, prints a cover page with detailed job information after the last sheet of
the job.

When Cover page is enabled on the FS2100C Server, it is turned on for all jobs. By default, Cover page prints on the
same media as the body of the job. For information about options specified in Configure, see Configuration and
Setup.
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The Cover page print option can be configured using one of the following settings:
¢ Same as job — uses the same media as the body of the job

e Custom — allows you to select specific media.

Note: Changes to the Cover page settings in Job Properties will override the Cover page setting in Configure for the
specific job.

Delivery option: Collate

The Collate print option allows you to specify how to output multiple-page/multiple-copy jobs.

¢ Sort: Copies of a complete job are sorted as 1-N, 1-N.

o Group: Copies of a complete job are sorted as 1,1, 2,2, 3,3.

Note: This option is invalid if your job is sent to the Direct connection.

Note: The collation of Mixed media and Variable Data Printing (VDP) jobs is handled differently. For Mixed media
jobs, copies of a complete job are sorted according to finishing set. For VDP jobs, copies of a complete job are sorted
per record.

For information about VDP, see Variable Data Printing.

For information about Mixed media, see Utilities.

Delivery Option: Continuous output

The Continuous output print option, when selected, switches from one output tray to another output tray
automatically if the output tray becomes full while printing.

Delivery Option: Offset jobs

The Offset jobs print option, when selected, offsets (shifts in output tray) the job.

The settings are as follows:

o Off: Copies of a complete job are not offset in the output tray.

¢ Between jobs: Completed jobs are sorted as 1-N, 1-N with offset stacking in the output tray.

o Between sets: Completed jobs are sorted as 1,1, 2,2, 3,3 with offset stacking in the output tray.
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Delivery option: Output delivery

The Output delivery print option allows you to specify the output delivery for the printed job.

Do one of the following for single-side printing:

¢ Select Face down - normal order to print your document on the bottom of the sheet of paper (the document
outputs from the printer with the text facing down) and the output stack starts from the top in normal (1-N)
order if the face down pile is put upside down.

o Select Face up - normal order to print your document on the top of the sheet of paper and the output stack starts
from the top in normal (1-N) order.

o Select Face down - reverse order to print your document on the bottom of the sheet of paper (the document
outputs from the printer with the text facing down) and the output stack starts from the top in reverse (N-1)
order if the face down pile is put upside down.

¢ Select Face up - reverse order to print your document on the top of the sheet of paper and the output stack starts
from the top in reverse (N-1) order.

Do one of the following for 2-sided (duplex) printing:

e Select Face down - normal order to print your document, for example 4 pages, with page 1/first page printed on
the first sheet face down and page 2 printed on the back, and page 3 printed on the second sheet face down and
page 4/last page on the back. The output stack starts from the top in normal (1-N) order if the face down pile is
put upside down.

o Select Face up - normal order to print your document, for example 4 pages, with page 3 printed on the first sheet
face up and page 4/last page on the back, and page 1/first page printed on the second sheet face up and page 2 on
the back. The output stack starts from the top in normal (1-N) order.

¢ Select Face down - reverse order to print your document, for example 4 pages, with page 3 printed on the first
sheet face down and page 4/last page on the back, and page 1/first page printed on the second sheet face down
and page 2 on the back. The output stack starts from the top in reverse (N-1) order if the face down pile is put
upside down.

o Select Face up - reverse order to print your document, for example 4 pages, with page 1/first page printed on the
first sheet face up and page 2 printed on the back, and page 3 printed on the second sheet face up and page 4/last
page on the back. The output stack starts from the top in reverse (N-1) order.

For more information, see Output delivery on page 101.

Delivery option: Output tray

The Output tray print option allows you to specify the output tray for the job.

Delivery Option: Print and pause

The Print and pause print option, when selected, prints a single copy of a job(s) to verify output.

A print job is stored and only one copy is printed. The remaining copies print after you enter information from the
printer control panel.

This function is available only when you print multiple-copies.
To print the document, release the held document from the printer control panel.

For information, see the documentation that accompanies your printer.



Printing 81
Print Options

Delivery Option: Rotate 180

The Rotate 180 print option, when selected, allows you to rotate the pages of your job 180 degrees.

Delivery Option: Slow printing

The Slow printing print option, when selected, prints the job at slower speed to lower the operating noise.

Fold: Fold order

The Fold order print option allows you to specify whether the pages of your folded job print with the imageable area
on the inside or outside of the folded sheet.

For more information, see Fold style options on page 98.

Fold: Fold style

The Fold style print option allows you to specify a fold style for the print job.

For more information, see Fold style options on page 98.

Fold: Z-fold binding edge

The Z-fold binding edge print option allows you to specify the location of binding edge for the fold.
If Z-fold for Fold style and Perfect for Booklet Type are selected, then this option is turned on.
To use this option, you must install a finisher with folding functionality.

For information about installing finishers and other installable options, see printer driver help.

Z-fold mixed size

The Z-fold mixed size print option, when selected, allows you to z-fold mixed paper sizes.

Image shift

The Image shift print option check box, when selected, adjusts an image for duplex printing by shifting the image
horizontally, in the direction of paper travel, relative to the leading edge.

This option affects the offsetting of the image for the entire job, not on a per-page-basis. However, you can specify
alignment settings for the front (odd) and back (even) pages.

Image shift settings are not available from inside Mixed Media.
Image shift is not supported for Booklet Maker and Gang-up printing.

For more information, see printer driver help.
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Image shift: Align front and back images

The Align front and back images print option, when selected, aligns the images on the front and back sides of the
page.

Image shift: Front and Back shift

Use the Front and Back print options to customize the image position along the x and y axes on the front or back of
the page.

Image shift: Units

The Units print option, in inches, millimeters, and points, specifies the unit of measurement for Front and Back
image shifts.

Mail making

The Mail making print option, when selected, allows you to use the print to mail feature by printing envelopes and
documents for mailing at the same time.

The Wrapping envelope finisher must be installed to use the print to mail feature.

For information about finishers and other installable options, see printer driver help.

Mail making: Mail form

The Mail form print option lets you select the envelope paper size for the print job.

The Mail making print option must be selected to use this option.

Mail making: Mail form tray

The Mail form tray print option lets you select the tray with the envelope paper size for the print job.

The Mail making print option must be selected to use this option.

Mail making: Duplex print (Mail form)

The Duplex print (Mail form) print option allows you to print on both sides of the envelope.
Select Off for single-sided printing.
Specify Top-top or Top-bottom for duplex (double-sided) printing by specifying the orientation of printed content.

The Mail making print option must be selected to use this option.

Mail making: Enclose

The Enclose print option specifies whether any sheets need to be inserted inside the envelope.

The Mail making print option must be selected to use this option.
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Mail making: Paper size (enclosures)

The Paper size (enclosures) print option lets you select the envelope sheet size.

The Mail making print option must be selected to use this option.

Mail making: Duplex print (enclosures)

The Duplex print (enclosures) print option allows you to print on both sides of the envelope insert sheet.
Select Off for single-sided printing.
Specify Top-top or Top-bottom for duplex (double-sided) printing by specifying the orientation of printed content.

The Mail making print option must be selected to use this option.

Mail making: Enclosures tray

The Enclosures tray print option allows you to select the envelope insert sheet tray.

The Mail making print option must be selected to use this option.

Mail making: Paper type (enclosures)

The Paper type (enclosures) print option allows you select the envelope insert sheet type.

The Mail making print option must be selected to use this option.

Mail making: Rotate enclosures 180 degrees

The Rotate enclosures 180 degrees print option allows you rotate the envelope insert sheet 180 degrees.

The Mail making print option must be selected to use this option.

Pad printing: Enable pad printing

Select the Enable pad printing check box to print pads.
Pad is a collection of a single or multiple page job with multiple copies.

For more information, see Pad printing on page 102.

Pad printing: Add pad back cover

Select the Add pad back cover check box to add a back cover at the end of the pad.

Pad printing: Back cover paper source

Specify the paper source tray to use for the pad back cover.
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Pad printing: Job copies per pad

Specify the number of pad copies to print.

Punch

The Punch print option allows you to specify the position of the holes to punch for your job.
To use this option, you must install a finisher with hole punching functionality.
For information about installing finishers and other installable options, see printer driver help.

For more information, see Punch position and hole punching on page 104.

Punch: Punch edge

The Punch edge print option allows you to specify the location of punched holes.
To use this option, you must install a finisher with hole punching functionality.

For information about installing finishers and other installable options, see printer driver help.

Slip sheet

The Slip sheet print option, when turned on, allows you to insert a blank or preprinted sheet as a separator between
copies of a job with a large number of pages based on user configuration.

A slip sheet offset can be specified. Slip sheets are never stapled with the job.

Slip sheets can be inserted before every copy, sheet, or set by selecting one of the following settings:

o Copies - inserts a sheet before every N copies of a job.

¢ Sheets - inserts a sheet before every N sheets.

e Sets - inserts a sheet before every N VDP records, subsets, chapters, or uncollated copies, for example 10 copies

of page 1, of a job.

Note: Slip sheets for Copies and Sheets are not supported for uncollated jobs.

Slip sheet: Slip sheet media

The Slip sheet media print option allows you to use the same media defined for the job or a custom media size for
the slip sheet.

The Slip sheet media can be configured using one of the following settings:
e Same as job — uses the same media as the body of the job

¢ Custom — allows you to select a specific media size.
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Stapler: Stapler mode

The Stapler mode print option allows you to specify the number of staples and their positions.
Staple positions vary according to paper size, paper type, number of pages, and feed direction.

To use this option, you must install a finisher with stapling functionality.

Note: A Saddle Stitch booklet job is stitched down the center of the page with two staples.

Use set page device output bin tray mapping

The Set Page Device (SPD) feature commands are instructions within the file that specify finishing attributes for the
print job.

The Set Page Device option must be turned on in Configure. (See Fiery Command WorkStation Help.)

Select the Use set page device output bin tray mapping check box in Job Properties to allow the FS2100C Server to
map the Output tray on a job-level basis including finishing attributes (for example, stapling or folding) on the
Finishing tab.

This option is only accessible from Command WorkStation Job Properties.

Variable Data Printing (VDP) options

The VDP tab shows all Variable Data Printing (VDP) settings, such as FreeForm and advanced VDP settings.
The FS2100C Server is compatible with the following variable data printing languages:

e FreeForm, FreeForm 2, and FreeForm Plus

Note: For information about FreeForm Plus files, see FreeForm Create Help.
e Portable Document Format/Variable Transactional (PDF/VT)
o Personalized Print Markup Language (PPML)
e Creo Variable Print Specification (VPS)
For more information about VDP languages, see Variable Data Printing.

VDP documents using FreeForm must have the following settings for the master document and variable document
match:

e Color mode

¢ Combine separations
e Duplex

¢ Orientation

e Documentsize

e Stapler mode
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The following setting for the variable document overrides the corresponding settings in the master document:

e Mediatype

e Paper source

Cache PDF and PS objects

The Cache PDF and PS objects print option, when selected, recognizes objects (text, images, vectors) within a
PostScript or PDF file. PDF objects must be tagged as XObjects and PS objects must be in PS form to be cached,
which reduces the need to re-process image data for faster printing.

This option is only accessible from Command WorkStation Job Properties.

For more information, see Variable Data Printing.

Create master

To create a FreeForm master from this job, specify a number to assign to the FreeForm master file.
Command WorkStation allows you to select up to 100 FreeForm masters.

For more information, see Variable Data Printing.

Enable enhanced FreeForm

Select to turn on Enable enhanced FreeForm to allow the mapping of select pages from the FreeForm master file in
the desired order and merge with the variable file when the job is processed.

You cannot apply FreeForm settings to an imposed job.

For more information, see Variable Data Printing.

File search path
Some PPML and other types of jobs do not contain all of the variable data job resources in a single file. In these cases,

on a job-per-job basis, specify the location of the variable data job external resources so that the FS2100C Server can
access them.

For more information, see Variable Data Printing.

Form: Form on top

The Form on top print option allows you to keep the form on top of the print job.

Preview Master

The Preview Master print option, when selected, generates a low-resolution image of your master page.

This option is not available for the macOS 10.14 or later printer drivers.
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Print master

The Print master print option, when selected, allows you to verify or confirm your Master page.
Select Printer’s default to use the setting specified in FS2100C Server Setup.

For more information, see Variable Data Printing.

Remove white PPT background

Select to turn on Remove white PPT background when using Microsoft Office PowerPoint to create variable data in
conjunction with FreeForm.

This option removes the white background from PowerPoint files.

Use master

For variable data print jobs, specify a FreeForm master number to be used for the job.
Command WorkStation allows you to select up to 100 FreeForm masters.

For more information, see Variable Data Printing.

Define record length: Define record length

Process a PDF or PostScript file like a variable data print job, and apply record-based finishing.
This option is used in connection with the Pages Per Record option.

For more information, see Variable Data Printing.

Define record length: Pages per record

Define record-based (rather than job-based) finishing, based on the number entered.
This option is used with the Define Record Length option.

For more information, see Variable Data Printing.

Stamping (Watermark) options

The Stamping tab shows all image stamping options that add or hide/remove any image on the job.
The watermark features are available from the printer driver only.

This also includes watermark properties that define the placement and style of the watermark. For information, see
printer driver help.

Copy numbering

The Copy numbering print option, when selected, prints the job with copy numbering.
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Copy numbering angle

The Copy numbering angle print option allows you to set the angle of the copy number printed for the print job.

Copy numbering font size

The Copy numbering font size print option allows you to select the font size for the copy number used for the print
job.

Copy initial number

The Copy initial number print option allows you to set the starting copy number for the print job.

Copy numbering transparency

The Copy numbering transparency print option allows you to print the copy number on each transparency.

Watermark

The Watermark print option allows you to select standard text for your watermark from the pull-down menu.
To create your own watermark, click New.

To modify a standard watermark, select it from the pull-down menu and click Edit.

To remove a watermark from the list, select it from the pull-down menu and click Delete.

For more information about using watermarks, see printer driver help.

Note: For Windows, do not select these fonts: AdobeSansMM and AdobeSerifMM.

Print Watermarks: First Page Only

The First Page Only print option check box, when selected, to specify how to print the watermark for the print job.
Select to turn on First Page Only to print a watermark only on the first page.

For more information about using watermarks, see printer driver help.

Override print option settings in Job Properties

Print option settings that were specified in the printer driver can be overridden in the Job Properties window of
Command WorkStation.

1 In Command WorkStation, right-click a job in the Held or Printed queue.
2 Select Properties.

3 Specify the print option settings, and then click Print.
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Exceptions to overriding print option settings in Job Properties

You can override most print options in the printer driver and Command WorkStation Job Properties. However, the
print options listed in the table below are the exceptions and can only be changed from the locations marked with an
X.

The exceptions are listed in the table.

Printer driver tab Option Driver Win | Driver Mac | CWS
Job Info Destination X X

Print Range X

Print queue action X X

User Authentication: User name X X

User Authentication: Password X X

User Authentication: Use Windows Login X

User Authentication: I'm a Guest X
Media Document size X

Use set page device media mapping X
Layout: Normal Mirror X

Orientation X

Orientation override X
Color Optimize RGB transparency X
Color: Expert Settings PDF/X output intent X
Finishing Use set page device output bin tray mapping X
Variable Data Printing (VDP) | Cache PDF and PS objects X
Stamping (Watermark) Watermarks X X

Print Watermarks: First Page Only X X
All tabs Adobe PDF Print Engine Preferred X
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Booklet Maker layouts in the printer driver and Command WorkStation Job Properties

Booklet Maker is the imposition tool that allows you to quickly print documents in booklet format, without the need
for more involved page imposition programs.

Booklet Maker provides advanced settings, while streamlining the booklet-making process by displaying only the
options and controls relevant to your selections. Booklet Maker is capable of imposing jobs from nearly any
application.

Access Booklet Maker in the printer driver when you print a job, or in Command WorkStation Job Properties.

Note: Mixed media jobs and variable data printing jobs are not supported by Booklet Maker.

The following booklet layouts are available:

Saddle binding: Signatures are folded together as a group, and then stapled or stitched along the center fold,
which forms the spine of the booklet. To use the saddle stitch option, you must install a finisher with folding
functionality.

1 Saddle (left) binding
2 Saddle (right) binding
3 Saddle (top) binding

Nested Saddle binding: Combines saddle and perfect binding methods by stacking two or more saddles (also
called “groups” or “subsets”) together along the common fold, then gluing them together at the fold to form the
spine.
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1 Nested Saddle (left) binding
2 Nested Saddle (right) binding
3 Nested Saddle (top) binding

Perfect binding: Separate, folded pages are printed and stacked in booklet order. Finished pages are stitched
adjacent to one another for trimming or gluing.
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1 Perfect booklet
2 Front(2,3,6,7)and Back (4, 1,8, 5)

For more information, see Booklet Maker Help.

For more information, see Booklet options in the printer driver and Job Properties on page 60.

Booklet Maker in the printer driver and Command WorkStation Job Properties

You can access Booklet Maker from the Layout tab in the printer driver and Command WorkStation Job Properties
when you print a job.

You can work with Booklet Maker as follows:

¢ Using the Booklet Maker wizard.
Recommended for first-time or novice users.
o Specifying settings in the main Booklet pane.

Recommended for experienced or advanced users.

For more information, see Booklet options in the printer driver and Job Properties on page 60.

Access Booklet Maker from the Windows printer driver

1 Inyour application, select File > Print.
2 Select the FS2100C Server as your printer and click Properties.

3 In the printer driver, click Layout and then select the Booklet option.

For more information, see Booklet Maker Help.

Access Booklet Maker from the Mac printer driver

1 In your application, select File > Print.
2 Select the FS2100C Server as your printer, and select Fiery Features from the drop-down list.

3 Click Full Properties in the Quick Access pane.
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4 In the printer driver, click Layout and then select the Booklet option.

For more information, see Booklet Maker Help.

Access Booklet Maker from Command WorkStation

1 Double-click your print job in the Held or Printed queue, or right-click the job and select Properties.
2 Click Layout in the Job Properties window.
3 Select the Booklet option.

4 Specify the Booklet Maker settings or click Launch Wizard to specify the settings graphically.

For more information, see Command WorkStation Help.

About Booklet Maker imposition

Imposition is the process of printing multiple pages on single sheets of paper.

When imposed sheets are folded together as signatures, the pages follow in sequential, or reading, order. Booklet
Maker is designed for 2-up imposition, which imposes four individual pages from your document on a single sheet
that is printed duplex.

The printer is equipped with an advanced finisher, that also allows 1-up Perfect binding. (See 1-up Perfect Binding
Booklet options on page 63.)

The order in which pages are imposed is determined by the binding method that you select.

Booklet Maker and Impose

Booklet Maker settings are supported by Impose, if turned on.

You can open a job with Booklet Maker settings in Impose to preview the imposition layout or further modify the
imposition layout, if necessary.

Impose translates and maps all Booklet Maker settings to Impose commands.

Note: When a job with Booklet Maker settings has been edited in the Impose window, the job can no longer be
edited in Booklet Maker. Impose offers more settings that cannot be mapped to Booklet Maker settings.

For more information about Impose, see Utilities.

Create a booklet with the booklet options in the printer driver or Job Properties

Booklet Maker dynamically displays all of the controls applicable to creating a booklet in the main Booklet Maker
window.

1 Select a Booklet Type: Saddle, Nested Saddle, or Perfect.

If your printer supports 1-up Perfect booklets, select 1-up Perfect for the Booklet Type. For more information, see
Booklet Maker: 1-up Perfect binding printing on page 95.
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Select a binding edge: Left, Top, or Right.

Specify a Paper Size.

Select Shrink to fit option, if required.

Specify Page alignment.

Specify Compensate creep, if required.

Creep compensation is available for saddle and nested saddle booklets.

Specify cover settings, if you selected a saddle booklet.

Note: Cover settings are only available for saddle booklets. (See Adding a cover to a Saddle booklet on page 93).

Click OK to save your settings, Cancel to cancel the job, or Print to print your job.

Create a booklet with the Booklet Maker wizard

In the Booklet Maker wizard, accessed by clicking Launch Wizard, the windows display the steps in the booklet-
making process.

1

2
3
4

Click Launch Wizard.
Specify the Booklet Type (binding method) and binding edge.
If Saddle was selected for Booklet Type, specify cover and content settings, and then click Next.

Specify paper size and media settings, and then click Next.
If Saddle was selected for Booklet Type, specify the paper settings for the cover, and then click Next.

If Nested Saddle was selected for Booklet Type, specify number of sheets in a subset.

Specify layout settings, and then click Next.

If Saddle or Nested Saddle was selected for Booklet Type, specify creep compensation.
View the settings summary.

Click Finish to save your booklet, Back to change any settings, or Cancel to cancel the job.

Adding a cover to a Saddle booklet

You can add covers (optional) for Saddle booklets.

Add a pre-printed cover to a Saddle booklet

1
2
3

In the main Booklet Maker window;, select Saddle for Booklet Type and a binding edge.
Specify the required settings for Paper Size and Page Alignment for the body of the booklet.

Select Pre-printed from the Cover: Content input menu.



4

5

Printing 94
Print Options

Click Define Cover and specify the cover media settings.

Click OK.

Add an inline cover to a Saddle booklet
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A u A~ W

In the main Booklet Maker window, select Saddle for Booklet Type and a binding edge.
Specify the required settings for Paper Size and Page Alignment for the body of the booklet.
Select Front & Back Separately from the Cover: Content input menu.

Specify the Front cover and Back cover settings.

Click Define Cover and specify the cover media settings.

Click OK.

Note: When you print an inline cover with top-edge binding, the outside back cover automatically rotates 180
degrees to match the orientation of the front cover.

Booklet Maker cover options for Saddle booklets

For Saddle only, Booklet Maker includes two cover options: pre-printed or inline, for which you can specify media.

You can specify additional options for an inline cover by specifying the following cover options:

Content input: Select from Front & Back Separately or Pre-printed.

Front & Back Separately: Select this option to specify an inline cover that prints the cover pages and body pages as

a single job. Separate pages from your document are imposed on a single sheet that forms the cover pages of your
booklet.

You can specify an inline cover when your original document includes the cover pages and/or cover artwork for
your booklet. The cover content may be the first and last pages of your document, or the first two and last two
pages of your document, or any combination.

If you select this option, you can specify the Front cover and Back cover options.

Pre-printed: Select this option to insert a pre-printed cover that will be merged with the body pages of your
booklet, which print separately.

If you select this option, the Front cover and Back cover options are disabled.

Front cover and Back cover: These options allow you to quickly decide whether your front and back covers print
duplex, single-sided, or both sides blank, without needing to add blank pages in your original document.

With top-edge binding that includes a cover, the outside of the back cover automatically rotates 180 degrees to
match the orientation of the front cover.

Define Cover: This option allows you to select cover media settings for your cover pages, which may be trimmed.
This option is available for both pre-printed and inline covers.
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Printing Booklet Maker jobs

Booklet Maker does not support jobs sent to the Direct connection. Booklet Maker print jobs must be sent to the
Print queue or Hold queue.

Set measurement units in Command WorkStation

You can change the default unit of measurement for all input fields in the Command WorkStation Preferences
window.

Units specifies the units of measurement used to display attributes, such as page sizes and custom sizes, that you
enter in the Job Properties window. This setting does not affect predefined page-size values.

1 In Command WorkStation, select Edit > Preferences.
2 Click Region to access Regional Settings.
3 Select the unit of measurement (millimeters, or inches).

4 Click OK.

The changes are not effective until Command WorkStation is restarted.

Booklet Maker: 1-up Perfect binding printing

The 1-up Perfect binding method prints single body pages that are stacked together, so that the edges may be
trimmed (if desired) and glued, and then wrapped by a cover sheet.

You can access the 1-up Perfect binding method from the printer driver or Command WorkStation Job Properties.

Note: If the printer is equipped with an advanced finisher, such as a Perfect binder, the option of 1-up Perfect
binding may be available.

Note: Do not print anything on the inner side of the cover sheet (the area glued to the book block). Doing so can
prevent the cover sheet and book block from adhering properly.

To print a 1-up Perfect booklet, you must select 1-up Perfect as the booklet type.

For more information, see 1-up Perfect Binding Booklet options on page 63.
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Defining and printing custom page sizes
With custom page sizes, you define the dimensions of a printed page. After you define a custom page size, you can
use it from within an application without redefining it each time you print.

When you create custom page sizes, specify width dimensions to correspond with the shorter side of your job and
specify height dimensions to correspond with the longer side of your job. Set custom page sizes in this way,
regardless of the orientation settings in the application.

@ @

@

1 Portrait orientation
2 Landscape orientation
3 Height

4 Width

Note: Custom page sizes are not supported with Imposition jobs.

For information about defining and printing custom page sizes, see printer driver help.

Document size and paper size

Document size is the page size defined in your application’s Print setup (or Page setup) dialog box.

Paper size is the size of the actual sheet of paper on which your job is printed. It may be useful to think of document
size as digital input (the page size defined in your original document) and paper size as the physical output (the
actual size of the paper in the printer tray).

In cases when you print one document page per sheet of paper, document size is usually the same as the paper size.
However, document size may differ from paper size when you print booklets or impose multiple document pages on
a single sheet.

The illustrations show examples of possible relationships between document size and paper size. Note that the
orientation of all pages shown is landscape.



Paper size is same as original size:

Original size

Paper size

Letter/A4

Letter/A4

Results:
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Scale to fit
(Sheet size)

Scale to fit

(Imageable area)

Scale = 100%

Command WorkStation

Printed result

(See note)

Paper size is different from original size:

Original size

Paper size

11x17/A3

Letter/A4
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Results:

Scale to fit Scale to fit Scale to fit

(Sheet size) (Imageable area) Scale = 100%

Command WorkStation

Printed result

(See note)

Note: The edges of the images may be cropped when printed because the blank spaces are added by the printer as
non-printable area. To reduce the size of the image to fit to the printable area, choose Scale to fit (Imageable area)
setting for the Scale to fit print option.

Document size may also differ from paper size when using the Scale or Scale to fit options. The Scale option reduces
or enlarges the document page at a specified percent. The Scale to fit option automatically reduces or enlarges the
document image to fit the selected paper size.

For information about document size and paper size in booklet printing, see Booklet Maker Help.

For more information, see Scale to fit on page 59.

Annotations

The Annotations feature allows you to add information in the header and footer sections of each document. This
information helps you to identify each document in FS2100C Server when you combine multiple documents into a
single booklet.

For more information, see FS2100C Server Help.

Note: This feature is available only for Fiery FS200 and newer servers.

Fold style options

The Fold style specifies how the folded job is printed.

You can specify whether the pages of your folded job print with the imageable area on the inside or outside of the
folded sheet.



The following types of folds are supported:

Fold style Fold illustration
2-fold
\
Booklet fold =
\\
Inner 3 fold
Outer 3 fold
Z-fold

A finisher capable of folding must be installed on the printer.

Note: When you select a folding option, Output delivery is automatically set to the correct setting. It is not possible
to print folded jobs face up or in reverse order. The Fold order option allows you to specify whether text/images
print on the inside or outside of the folded sheet.

For information about finishers and other installable options, see printer driver help.

Gang-up printing

Gangup layout options are used for speed printing imposition modes.

The FS2100C Server includes two speed-printing options for gang-up printing:
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e Step &repeat - Select this option to speed print a job so that the first page of your document is printed twice on

the first sheet. The next sheet duplicates the data on the second page, the next sheet duplicates the data on the

third page, and so on. When the printed sheets are cut in half, the result is two complete sets of the same

document.
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1 Single-sided, front only
2 Duplex (double-sided), front (1, 3) and back (2, 4)
e Cut &stack - Select this option to speed print a job so that when the sheets are stacked and cut from the central

position, the job is numbered in order and separated as two stacks. The print order is such that when the sheets
are cut in half, you can combine them to form a single complete set of the document, in faster printing time.
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1 Single-sided, front only
2 Duplex (double-sided), front (1, 3, 5, 7) and back (2, 4, 6, 8)

For more information, see Gangup layout options on page 59.

Access Gang-up print from the Windows printer driver

1 Inyour application, select File > Print.
2 Select the FS2100C Server as your printer and click Properties.

3 In the printer driver, click the Layout icon and select the Gangup option.

Access Gang-up print from the Mac printer driver

-

In your application, select File > Print.

2 Select the FS2100C Server as your printer and select Fiery Features from the drop-down list.
3 Click Full Properties in the Quick Access pane.
4

In the printer driver, click the Layout icon and select the Gangup option.
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Image enhance

The Image enhance feature lets you apply photo finishing enhancement to color images on specified pages or sheets
of a job. This feature affects only photographic images, not graphics such as logos or charts.

To turn on this feature, select the Apply image enhancement check box for a job and specify the pages or sheets to
be affected. This option is located under the Image tab of the printer drivers and in the Job Properties window of
Command WorkStation. You can customize Image Enhance settings from Command WorkStation.

For more information, see Command WorkStation Help.

Output delivery

Output delivery allows you to specify how the stack of copies is delivered in the output tray.

Do one of the following for single-side printing:

o Select Face up for sheets delivered into the output tray with copies facing up, with normal order for the first page
on the top of the stack, or reverse order for the first page on the bottom of the stack.

o Select Face down for sheets delivered into the output tray with copies facing down, with normal order for the
first page on the bottom of the stack, or reverse order for the first page on the top of the stack.

1 Faceup -normal order
2 Face up - reverse order
3 Facedown - normal order

4 Face down - reverse order
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Do one of the following for 2-sided (duplex) printing:

o Select Face up for 2-sided sheets delivered into the output tray with copies facing up, with normal order for side
1 of the first sheet on the top of the stack, or reverse order for side 2 of the first sheet on the bottom of the stack.

¢ Select Face down for 2-sided sheets delivered into the output tray with copies facing down, with normal order
for side 2 of the last sheet on the top of the stack, or reverse order for side 1 of the last sheet on the bottom of the
stack.
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1 Face up - normal order
2 Face up - reverse order
3 Face down - normal order

4 Face down - reverse order

Note: When using a finisher that reverses the order of the stack, you can specify normal order so that when the stack
is fed through the finisher, the pages are delivered in the correct order.

Pad printing

Pad printing gives you control over printing multiple copies of a job without having to perform unnecessary mental
calculations or requiring multiple steps every time.

With the Pad printing print options on the Finishing tab of the printer driver or Command WorkStation Job
Properties, you can specify pad-printing parameters. You can define the contents of each pad, including the number
of times the job repeats within a pad.
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It duplicates a single job as many times as defined in the Pad printing settings to create one finished or merged pad.
You can add a back cover.

Pad printing also allows you to simply assemble printed pads with a back cover, similar to sticky notes. When cover
has been turned on for pad printing, the page size and orientation of the cover media should be the same as the main

job.
You can use the Job copies per pad print option to specify the number of pads in the job. Pad copy packs are offset in
the output tray for easy separation for offline binding.

An example of a job printed with the Pad printing settings.

&>—4

1 Each sheet of each pad is printed duplex (double-sided) and repeated 25 times.

2 Aback cover is added.

Print Duplex (double-sided) pages

1 Inyour application, do one of the following:

¢ On macOS computers: Select File > Print, select the FS2100C Server as your printer, select Fiery Features from
the drop-down list, click Full Properties in the Quick Access pane, and then select Normal on the Layout tab.

¢ On Windows computers: Select File > Print, select the FS2100C Server as your printer, click Properties, and
then click the Layout icon.
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2 Select one of the Duplex settings:

e Top-top: Prints the top of the image on Side 1 on the same edge of the page as the top of the image on Side 2.

¢ Top-bottom: Prints the top of the image on Side 1 on the opposite edge of the page from the top of the image

on Side 2.
Orientation | Top-top Top-bottom
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Portrait 1 2 1 O o

[ 2N | o O o n 4
Landscape 1 2 1 ao

3 Print the job.

Punch position and hole punching

You can specify the number of holes to punch and the location of the punched holes.

A finisher capable of punching must be installed on the printer.

Note: Punch positions vary according to paper size, paper type, number of pages, feed direction, and original
orientation.

Note: Punch can only occur on the lead or trail edge of the paper. The paper orientation may need be changed in the
printer to accommodate all of the punch configurations.

Punch Portrait: Left | Portrait: Right | Portrait: Top | Landscape: Left | Landscape: Landscape: Top
setting Right
2 holes 5o o o 5 ©
o
‘R R’ R - R R. R
o
3 holes ° o coo ° 600
‘R Rs R °R Rs
o o
4 holes o ° 0000 8 ° 000O0
o
:R RS R :R R: R
o ]

For information about finishers and other installable options, see printer driver help.
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User Authentication

If Users and Groups user authentication is configured in FS2100C Server Setup, you must enter a valid user name
and password to send a print job to the FS2100C Server.

In Command WorkStation, the management of jobs is determined by how you log on to the FS2100C Server.

The print options associated with Users and Groups user authentication are as follows:

e On Mac computers: Click Job Info and type logon information in the User name and Password fields.

e On Windows computers: Click Job Info and set the following:

e Use Windows Login - Select this option if you are already logged on to a Windows computer. Otherwise, type
your Windows network logon information in the User name and Password fields.

e Validate - Click to validate user authorization and to confirm printing privileges. To validate, Two-Way
Communication must be turned on. For information on establishing Two-Way Communication, see printer
driver help.

e I'ma Guest - Select this option to activate guest printing privileges. By default, guest printing is turned on.

For information about turning on Users and Groups user authentication in Configure, see Configuration and Setup
and Command WorkStation Help.
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Supplemental printing information

This section supplements the documentation for your printer and print server to correct and clarify the information
that appears in those documents.

Keep the following in mind when using the ComColorExpress FS2100C.
e The FS2100C Server does not have Japanese fonts.

If font errors are printed, verify the font settings after the printer driver is installed.

1 Right-click the printer in the Devices and Printers Control Panel and then display the ComColorExpress
FS2100C Printing preferences window.

2 On the PostScript tab, set True Type Font Setting to Download as Softfont.
3 Click Apply.

Note: Please make sure the Japanese fonts are installed before printing Japanese specific test files.
¢ While receiving a job, Fiery Ticker's Remaining time display is not accurate.

¢ When scanning with the FS2100C Server and the scan size is set to Automatic, please use short edge feed
direction.

If the scan size is set to Automatic and you want to scan with paper in the long edge feed direction, then
interchange the Portrait and Landscape settings in Orientation on the Scan window.

e For macOS, it takes about 10 minutes to acquire printer driver information, such as Paper Catalog information,
ink information and master used.

e The FS2100C Server's barcode processing is specific to the barcode area in the source document. The FS2100C
Server detects the barcode area automatically. The automatic detection of barcode allows you to process the
barcode area with an optimized method.

e For macOS, do not change the orientation of the Adobe Reader Print window from Automatic portrait /
landscape.

When printing a landscape document as a perfect booklet job with top binding, the Orientation option needs to
be set as Landscape on the Page Setup window.

How to determine the print position adjustment for 1-up Perfect Right binding
1 Measure the thickness of the body in advance and obtain the width of the spine.
2 The print position adjustment value is calculated by the following equation:
Cover Position adjustment horizontally = Cover Paper Size - [(Body Paper Size)x2 + Spine width]

3 Add a negative sign to the obtained print position adjustment value and type the value in the Cover Position
adjustment horizontally setting for 1-up Perfect Right binding booklet on the Layout tab in the printer driver.
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